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Preliminary Remarks 

We have organised the chapters of this study text according to the outline of the 
entire specialised area “Computer Applications”, which includes the content both 
for face-to-face and for self-learning phases. For a better understanding, you find 
the number of the original chapter within brackets in each heading of a chapter. 
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1 MS Windows (Chapter 2) 

Learning Objectives 

Upon successful completion of this chapter, you will be able to: 

 Describe some of the basic functions of an operating system and Windows 
in particular 

 Describe the parts of the Windows desktop environment 
 Feature of Window 7 OS feature 
 Install Windows 7 OS 
 Use of Disk cleanup utility  
 Create and manage different types of user accounts 
 Use Parental Control Utility 
 Use Microsoft Security Scanner and MS Security Essential to clean com-

puter from viruses. 

1.1 Introduction to MS Windows 

When a computer is powered on, you’ll hear some beeping as it does some hard-
ware checks and then the operating system loads. Every computer needs an 
operating system which lets you, literally, operate your computer. There are a 
few around and Microsoft Windows is just one of them, albeit one of the most 
popular ones. A computer running the Windows Operating System may display 
a login screen or it may show the desktop immediately, depending on the setup. 
The Apple Macintosh family of computers runs a different operating system 
called Mac OS. When you purchase software, you must be sure to check the 
system requirements and purchase software for the operating system you are 
using. For example, software purchased for the Windows Operating System will 
not work on an Apple Macintosh. 
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1.1.1 Key Features Include 

Some of the functions the Windows operating system allows you to do are:  

 Access applications (programs) on your computer (word processing, 
games, spread sheets, calculators and so on)  

 Load any new programs on to the computer  
 Manage hardware such as printers, scanners, mice, digital cameras  
 Manage how files are stored on your computer (File Management, cover-

ed later in this module)  
 Change computer settings such as color schemes, screensavers and the 

resolution of your monitor.  
 Plug and play capability with hardware and peripheral devices 
 Completely customizable task bar 
 Jump lists 
 Home group networking 
 Low memory footprint 

Microsoft Windows is a group of OSs manufactured by Microsoft. Windows is 
available in 32 and 64-bit versions and offers a graphical user interface (GUI), 
multitasking functionalities, virtual memory management capabilities and 
support for several peripheral devices. Windows OSs constitute client as well as 
server versions. 

Windows 7 is a computer operating system with graphical user interface (GUI), which 
enables you to work with a wide variety of programs on your computer, often 
simultaneously. Windows 7 is itself a special computer program that communi-
cates your instructions to the actual computer hardware and displays the results. 

Important aspects for selecting a Windows Operating System: 

The most important aspects are the purpose and function which you intend to 
perform using your computer. After deciding your computer's primary function, 
you will need to decide what kind of networking and administrations tools you 
need and the level of security you desire  
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1.2 MS Windows 

1.2.1 Important Features of Windows Operating Systems: 

Home and Office Use: We assessed the operating system in terms of how well it 
supports general home use; for example, it should have basic Internet security 
and be easy to use. OSs for office or business use need sophisticated Internet 
security, the capacity to network and ought to include administration tools. 

Multimedia Use: Some OSs are designed to entertain, these can play/record 
television, burn DVDs and can support HD video and music without supple-
mentary software. 

Security: All OSs should provide frequently updated security features such as 
firewalls, pop-up blockers, antivirus and antispyware software and more. OSs 
for business or network use requires additional security and administrator tools. 

Networking: Business and home OSs can be used in a network. These systems 
should offer administration tools and security. 

Ease of Use: All OSs should be straightforward; we looked at its search functions 
and more to rate the ease of use. 

Technical Help/Support: Since OSs perform numerous functions, above average 
support is needed. Generally, Microsoft offers more support choices to its 
business customers and mostly self-guided support for individuals. 

1.2.2 Windows within Windows 

A Window refers to a rectangular area of the screen, within which you may view 
program folders and files or display file contents such as documents, spread-
sheets and graphic images. A window can occupy part of the screen, can be 
maximized to fill the entire screen or can be minimized so that it is no longer 
visible but remains active and is easily re-accessed.  

Using Desktop, Taskbar or Start Menu. 
The Desktop: The icons that are visible on your desktop depend on choices 
made at installation. In labs, you will usually see icons for 

 My Computer (the gateway to your computer’s drives or data storage 
areas) 

 Recycle Bin (a temporary “trashcan” that holds files you want to delete) 

The Taskbar: The Taskbar lies across the bottom edge of your screen. The Start 
button on the left provides access to all the programs, data files and other 
features available on your computer. When you open a program or file, a 
corresponding rectangular icon will be displayed on your taskbar - even if the 
program has been minimized and is no longer visible on your screen. To access 
that program, you just need to click its icon on the taskbar!  
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The Start menu: When you click on the Start button, a set of menu options is 
displayed. The contents will vary depending on your computer setup and most 
frequently accessed programs. If you click on the All Programs option, you’ll see 
a list of all the programs installed on your computer – even those that don’t have 
icons on the desktop. Press the [ESC] (escape) key to close the menu. 

1.2.3 Installing Windows 

The hardware requirements for installing Windows 7 operating system are given 
below. You need to check it in advance before installing the operating system.  

 CPU: 1 GHz with 32 bits or 64 bits. 
 RAM: 1 GB Ram for 32 bits or 2 GB Ram for 64 bits. 
 HDD: 16 GB empty space hard disk for 32 bits or 20 GB for 64 bits. 
 DVD drive:  in working condition (if installing from a DVD). 

Before starting installation to your computer please make sure to have the 
following items: 

 Windows 7 installation disk 
 CD/ License  Key  
 Drivers CD: (It is needed after installation process) 
 NOTE: Please make sure to back up all of your important data from the 

hard disk before proceeding with this installation. 

Now follow these steps to install Windows 7 on your computer: 

1) Turn your computer on then press Del or F2 (depends on your computer’s 
mainboard) to enter the system BIOS. 

2) Go to Boot menu and choose Boot from CD/DVD. 

3) Press F10 to save the configuration and exit BIOS then reset your computer.  

4) Insert the Windows 7 operating system disk into your DVD drive and then 
restart your computer. Windows 7 will start loading files. 

5) Select for these options:  

a) Language to Install 
b) Time and currency format 
c) Keyboard or input method 

6) Click Install Now. 

7) Check the box I accept the license terms in Please read the license then click Next 
to accept the End User License Agreement (E.U.L.A.) . 

8) A window will appear asking about Which type of installation do you want?. 

a) Upgrade: if you want to upgrade from an older Windows version to 
Windows 7. 

b) Custom (advance) if you want to install a new version of Windows. 
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9) Where do you want to install windows? Make sure the partition is highlighted.  

10) Delete the partition by clicking on Drive options (advanced) on the bottom 
right corner of the field. 

11) Make sure the partition is highlighted and click on Delete. If drive advanced 
options is greyed out, then the partition will not have to be deleted. 

NOTE: Deleting the partitions will erase all data on the system. Choose Partition 
for installation, if your computer has only one hard disk, it will be easy for 
selection, but if it has some partitions, you will have to consider which partition 
to choose. 

12) Disk 0 Unallocated Space should be the only listing at this point. If it is press 
next, if not please proceed to delete any additional partitions that may be 
listed. 

13) The next screen will show Installing Windows. This process should take 
approximately 10 minutes after which the system will reboot.  

*NOTE: Do not press any keys during this boot up process so as to not disturb 
the rest of the installation. 

14) The next screen will show Installing Windows again to complete the 
installation process. 

15) Setup is starting Windows will appear on the screen, then you will be asked to 
create a user name and a computer name. 

16) Type you’re a user account and computer name. After that click Next. 

17) Now you will be prompted you create a password for your account 
(optional). 

18) Type a password for your account, you can also type a password hint to 
help in case of forgetting the password in the future and then click Next. 

19) Type in activation code or key for your license in Product key box if you have 
any. Click Next. 

20) Choose how to protect your Windows. Here we choose Use recommended 
settings. 

21) This will allow you to choose your local time zone and also adjust the date 
and time. 

22) The next screen will come up and ask you to choose one of three options:  

a) Use recommended settings  
b) Install important updates only  
c) Ask me later 

23) Set up your Time zone, then click Next. 

24) Choose an option from 3 choices:  
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a) Public Network  
b) Work Network 
c) Home Network 

25) Click on the appropriate location of your computer to enable Windows 7 to 
apply the correct network settings. Choose Home Network for using Internet 
at home. 

1.2.3.1 Some Errors during Windows 7 Installation 

After Windows 7 installation, if there are problems, e.g. connecting with the 
internet, please check these troubleshooting:  

 Make sure Internet cable and the modem are working properly, the 
connection points are not getting loose. 

 Check the network drive (normally Windows 7 automatically detects 
drivers). 

 Set up Windows IP if the modem doesn’t analyze it automatically 
(searching on Internet for how to set it up). 

 Some devices might not work such as: USB 3.0, Webcam, Bluetooth etc. 
then you should check the driver to see if it has been installed properly. 

1.2.4 Installing/Uninstalling different Software/Antivirus programs 

How you add a program depends on where the installation files for the program 
are located. Typically, programs are installed from a CD or DVD, from the 
Internet or from a network.  

To install a program from a CD or DVD 
Insert the disc into your computer and then follow the instructions on your 
screen. Administrator permission required If you're prompted for an administra-
tor password or confirmation, type the password or provide confirmation. 

Many programs installed from CDs or DVDs open an installation wizard for the 
program automatically. In these cases, the AutoPlay dialog box appears and you 
can choose to run the wizard. For more information, see AutoPlay: frequently 
asked questions.  

If a program doesn't begin installation automatically, check the information that 
came with the program. This information will likely provide instructions for 
installing the program manually. If you can't access the information, you can also 
browse through the disc and open the program setup file, usually called 
Setup.exe or Install.exe.  

To install a program from the Internet 
In your web browser, click the link to the program. Do one of the following: 

(1) To install the program immediately, click Open or Run and then follow the 

instructions on your screen.  If you're prompted for an administrator 
password or confirmation, type the password or provide confirmation. 
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(2) To install the program later, click Save and then download the installation 
file to your computer. When you're ready to install the program, double-
click the file and then follow the instructions on your screen. This is a safer 
option because you can scan the installation file for viruses before you 
proceed. 

To install a program from a network 
If you connect your computer to a domain (such as an internal corporate 
network) that has programs that you can add, you can install programs from 
Control Panel. 

1) Open Get Programs by clicking the Start button , clicking Control Panel, 
clicking Programs, clicking Programs and Features and then, in the left pane, 
clicking Install a program from the network.  

2) Click a program in the list and then click Install. 

3) Follow the instructions on your screen.  If you're prompted for an ad-
ministrator password or confirmation, type the password or provide 
confirmation. 

To Uninstall or Change a Program 
1) Open Programs and Features by clicking the Start button , clicking Control 

Panel, clicking Programs and then clicking Programs and Features. 

2) Select a program and then click Uninstall. Some programs include the option 
to change or repair the program in addition to uninstalling it, but many 
simply offer the option to uninstall. To change a program, click Change or 

Repair.  If you're prompted for an administrator password or confirma-
tion, type the password or provide confirmation. 
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1.2.5 How to Remove Programs (Windows 7) 

We can use Add/Remove programs utility of windows 7 to install/uninstall 
programs. 

1) Open the Control Panel. You can access the Control Panel from the Start menu. 
The Start menu can be opened by clicking the Windows logo in the bottom-
left corner of the display or by pressing the Windows key on your keyboard. 

2) Open Programs and Features. The Control Panel is typically displayed in one 
of two different ways: either a Category View or an Icon view. Category view 
will have 8 or 9 icons with a few options under each one, while Icon view 
will be a large list of icons. 

a) In Category view, click the Uninstall a program link under the category 
Programs. 

b) In Icon view, click the icon Programs and Features. 

3) Find the program you want to uninstall. When you open Programs and 
Features, you will see a list of all of your installed programs. You may need 
to wait a few moments for the list to fully load. Click the program in the list 
to select it.  

If the program you want to remove does not appear on the list, check to see 
if it has its own uninstallation tool. This will be typically located in the Start 
menu group, which you can get to by clicking Start → All Programs 
→Program Name or Company. 

 If you can’t find the uninstallation tool anywhere, it may be malware and 
will need special procedures to remove. Download a program such as Mal-
warebytes and scan your computer for malware. 

4) Click the button Uninstall. This will appear in the top toolbar when a 
program is selected in the list. You can also right-click on the program to 
find Uninstallation in the menu that appears. Click it to begin the un-
installation process. You will be asked if you want to continue. 

5) Follow the prompts. Different programs will have different uninstallation 
programs. You may get asked if you want to keep settings in configuration 
files. If you plan on reinstalling the program at a later date, leaving these 
could make getting it set up easier.  

 If the program refuses to uninstall or reappears after being installed, you 
probably have a virus. To deal with a virus, you may need to run several 
different virus removal programs. See this guide for some tips on dealing 
with virus infections. 

6) Run an extra cleaning program. A lot of times, stray files and registry entries 
will be left behind during the uninstallation process. These can gum up your 
computer over time, especially if you are installing and uninstalling pro-
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grams on a regular basis. Programs such as CCleaner can help to remove 
these stray files and keep your computer running smoothly.  

7) If you are removing many programs at one time and are freeing up a 
considerable amount of space, you may want to defragment you hard disk 
drive to improve your computer's performance. 

Activity 1 

What operating system do you have on your computer at home? 

__________________________________________________________
___ 

__________________________________________________________
_ 

What version of operating system do you have on your computer and on your 
computer in the institutions’ computer Lab? 

______________________________________________________________________ 

______________________________________________________________________ 

What is the specification of the computer at your home? 

______________________________________________________________________ 

______________________________________________________________________ 

What are the different software applications installed on your computer? 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 
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1.3 Managing User Accounts and Parental Controls 

In Windows 7 users who share a computer can have their own user account, 
personal settings of computer. It also allows parents to set up Parental Controls 
to limit the types of games and programs their children are able to use.  

Before you start making new user accounts, it's important to understand the two 
types of accounts: 

 Standard: Standard accounts are the basic accounts you use for normal, 
everyday tasks. As a Standard user, you can do just about anything you 
would need to do, such as running software or personalizing your desk-
top. Also Parental Controls can be placed on Standard accounts. 

 Administrator: Administrator accounts are special accounts that are used 
for making certain changes to system settings or managing other people's 
accounts. They have full access to every setting on the computer. Every 
computer will have at least one Administrator account. 

Standard accounts are safer everyday use. In fact, you can make Administrator-
level changes while logged into a Standard account; you will just need to provide 
an Administrator password when making the changes. 

1.3.1 Creating User Accounts 

1) Go to the Control Panel from the Start Menu.  
2) Click Add or remove user accounts. 
3) The Manage Accounts pane will appear you can add more accounts or 

manage existing ones through this account.  

1) Choose the account you want to change. 
2) Click to create a new account. 

1) From the Manage Accounts pane, click Create a new account. 
2) Type an account name. 
3) Select Standard user or Administrator. 
4) Click Create Account. 
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1.3.2 Changing Account Settings 

Setting Password: 
1) From the Manage Accounts pane, click the account name or picture. 
2) Choose the account you would like to change. 
3) Click create password. 
4) Type a password in the New password field and retype it in the Confirm new 

password field. 

If you want, you can type a password hint to help you remember your password. 

1) Click Create password. 
2) To go back to the Manage Accounts pane click Manage another account. 

1.3.3 Using Parental Controls 

Parental Controls in windows 7 help you control the types of content your 
children can access. You can place parental controls on any Standard account 
and each account can have different settings. You can always change the Parental 
Controls settings as your children get older. 

To set up Parental Controls: 

1) Go to the Control Panel from the Start Menu. 
2) Click Set up parental controls for any user. 
3) Click on any  Standard Account. 
4) Click On to turn Parental Controls on. 
5) From Parental Control Main page you can click  

a) Time limits 
b) Games 
c) Allow and block specific programs to set the Parental Controls.  

Time limits 
The time limits settings allow you to control when your children can use the 
computer. Click and drag from any box to allow or block a section of time. If you 
want, you can set different time limits on different days. For example, you may 
want to allow more computer use on weekends. 

Games 
The Games settings allow you to select which game ratings to allow and you can 
also allow or block specific games. First, you'll have to click Yes to allow your 
children to play games, then you can change your Games settings. 
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To allow or block specific programs: 
Allow and block specific programs controls which nongame programs your 
children can use. By default, your children can use all nongame programs. But 
there may be some programs you don't want your children to use, like a financial 
or email program. Here's how to block specific programs: 

 Click option “User Name” can only use the programs I allow. 
 Click Check All to allow all programs or  
 Uncheck the programs you want to block. 

Activity 2 

1) Create a new account with administrative rights? Set a 
password for this account. Login using this new account 
and note down what administrative tasks you can 
perform. 

________________________________________________________
__ 

___________________________________________________________ 

______________________________________________________________________ 

 

2) Create a new account with standard rights? Set a password for this account. 
Login using this new account and note down what administrative tasks you 
can perform. 

______________________________________________________________________ 

______________________________________________________________________ 

 

3) Apply the parental control on the newly created standard account? Write 
the steps that you have to perform. 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 
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1.3.4 Windows 7 - Disk Cleanup /Virus Cleanup 

Disk Cleanup (cleanmgr.exe) is a computer maintenance utility included in 
Microsoft Windows designed to free up disk space on a computer's hard drive. 
The utility first searches and analyzes the hard drive for files that are no longer 
of any use and then removes the unnecessary files. There are a number of 
different file categories that Disk Cleanup targets when performing the initial 
disk analysis such as:  

 Compression of old files 
 Temporary Internet files 
 Temporary Windows files 
 Downloaded program files 
 Recycle Bin 
 Removal of unused applications or optional Windows components 
 Setup log files 
 Off-line files 

1.3.4.1 Steps to delete files 

If you have more than one drive or partition on your computer, you will be 
prompted to choose which drive you want Disk Cleanup to clean. 

You can open Disk Cleanup by clicking 

1) Start button,  
2) All Programs 
3) Accessories 
4) System Tools  
5) Disk Cleanup 

Note: Here's another way to open Disk Cleanup: Click the Start button. In the 
Search box, type Disk Cleanup and then, in the list of results, click Disk Cleanup. 

Once you launch Disk Cleanup, if you have more than one hard disk in your 
system, you'll be prompted to select drive you want to clean. Disk Cleanup will 
begin to analyze the files on your hard disk to determine what can be safely 
removed. It will calculate how much space you'll be able to free up. The main 
Disk Cleanup interface displays a list of unnecessary files, their size and a check 
box. Check box allows you to specify that you want to remove those files.  
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1.3.4.2 Removing a Computer Virus 

If your computer is infected with a virus, you'll want to remove it as quickly as 
possible. A fast way to check for viruses is to use an online scanner, such as the 
Microsoft Safety Scanner. The scanner is a free online service that helps you 
identify and remove viruses, clean up your hard disk and generally improve 
your computer's performance. 

Microsoft Safety Scanner 
The Microsoft Safety Scanner is a free downloadable security tool that provides on-
demand scanning and helps remove viruses, spyware and other malicious 
software. It works with your existing antivirus software.  

Note: The Microsoft Safety Scanner expires 10 days after being downloaded. To 
rerun a scan with the latest anti-malware definitions, download and run the 
Microsoft Safety Scanner again. 

The Microsoft Safety Scanner is not a replacement for using an antivirus software 
program that provides ongoing protection.  

For real-time protection that helps to guard your home or small business PCs 
against viruses, spyware and other malicious software, download Microsoft 
Security Essentials. 

Microsoft Security Essentials is a free product you can download to help defend 
computers running Windows Vista and Windows 7 against viruses, spyware and 
other malicious software. 

 Comprehensive protection—Microsoft Security Essentials helps defend 
your computer against viruses, worms, Trojans and other malicious 
software and provides you with free spyware protection.  

 Easy to get, easy to use—Microsoft Security Essentials is available at no 
cost, so there's no registration process that requires billing or personal 
information collection. It installs after a quick download and then stays 
automatically up to date with the latest spyware protection technology 
and signature updates.  

 Quiet protection—Microsoft Security Essentials doesn't get in your way. It 
runs quietly in the background and schedules a scan when your computer 
is most likely idle. You only see alerts when you need to take action.  
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Activity 3 

1) Which utility (exe program) is used to clean the disk? 

_______________________________________________________________________ 

_______________________________________________________________________ 

 

2) What is Microsoft Safety Scanner and what are its functions? 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

 

3) What is Microsoft Security Essential and what are its functions? 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

 

4) Differentiate between Microsoft safety scanner and Microsoft Security 
Essential. 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 
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Task 

Task 1 

The student should look upon the task as a test of knowledge, 
management skills and communication skills. When you write an 
answer asked in the task, you are indicating your knowledge to 
the teacher: 

 Your level of understanding of the subject. 
 How clearly you think. 
 How well you can reflect on your knowledge & experience. 
 How well you can use your knowledge in solving problems, explaining 

situations and describing organizations and management. 
 How professional you are and how much care and attention you give to 

what you do. 

Give Answers to these questions: 
1) Describe the basic computing functions of Operating Systems. 

2) Explain the main features of Windows 7 operating system. 

3) Discuss the Windows 7 Desktop in detail. How the new desktop is different 
from those of earlier versions of Windows.  

4) What are the minimum hardware requirements for installing Windows 7 
OS?  

5) What kind of OS are there for the Mac Computers? What is the difference 
between Windows 7 OS and Mac OS? 

6) List the steps for installing/uninstalling application software. 

7) What are the different types of files we can delete using Disk Cleanup tool? 

8) Why are different types of user accounts created? What are the purposes of 
Parental Control? 

9) Download, install and use Microsoft Security Essential on your computer. 
Scan and clean the viruses from your computer. Describe the whole process 
and report what different viruses are cleaned by it.  

10) Write an essay on the following topic: 

Role of an Operating system on the performance, security and usability of 
the computer.  
Your essay should be from 800 – 1000 words.  

 

If there are any questions, please do not hesitate to contact  

Dr. Shafiq ur Rehman via e-mail: shafiqurrehman1@yahoo.com  
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2 Word Processing Software Advance Features (Chapter 3) 

Learning Objectives 

Upon successful completion of this chapter, you will be able to 

 understand and use the Word Processing Software Advance Features, like 
clipboard, options of “Paste Special”, formatting styles, using the command 
in the “editing group”, creating tables and apply formulas 

 Create index and Cross reference of tables 

2.1 Word Processing Software Advance Features 

Microsoft Word 2010 makes it easier to create, format, collaborate and to navigate 
through long documents. For more impact, new features focus on the appearance of 
your finished document. With this new version, you can access the richness and 
familiarity of Word in your browser and on your mobile phone. In this chapter you 
will learn about some advanced features of MS Word 2010.  

2.1.1 Clipboard 

The clipboard is the location in a computer operating system such as Microsoft Win-
dows that stores information that has been cut or copied from a document or other 
location. The clipboard will hold this information until it has been overwritten by 
new information. For example, a user may copy information from a word processor 
and paste that information into an e-mail message. 

Clipboard is a special memory area (buffer) where data is stored temporarily before 
being copied to another location. Many word processors, for example, use a clip-
board for cutting and pasting. When you cut a block of text, the word processor 
copies the block to the clipboard; when you paste the block, the word processor 
copies it from the clipboard to its final destination. In Microsoft Windows and the 
Apple Macintosh operating system, the Clipboard (with a capital C) can be used to 
copy data from one application to another. 

The Macintosh uses two types of clipboards. The one it calls the Clipboard can hold 
only one item at a time and is flushed when you turn the computer off. The other, 
called the Scrapbook, can hold several items at once and retains its contents from 
one working session to another. 
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Figure 2: Clipboard Content 

The Office Clipboard stores text and graphics that you copy or cut from anywhere 
and it lets you paste the stored items into any other Office file. Here's how it works 
in Word 2013. 

1) If you're not already there, click Home, then click the launcher in the lower-
right corner of the Clipboard group (Figure 1).  

 

Figure 1: Clipboard Launcher 

2) Select the text or graphics you want to copy and press Ctrl+C. You can also 
press Ctrl+X to cut the text or graphics.  

Each selection appears in the Clipboard (Figure 2), 
with the latest at the top. You can copy (or cut) 24 
items and they stay in the Clipboard until you close 
all your Office programs.  

Optionally, repeat step 2 until you've copied all the 
items you want to use. 

After you open the Clipboard, it stores content that 
you copy or cut from anywhere. The same thing 
happens when you set the Clipboard to store content 

but remain closed, as long as you have an Office 
program running. For more about that, see Set 
options for the Clipboard below. 

You can do the following from the clipboard:  

Paste items from the Clipboard 
You can paste items into any Office file that you have open, individually or all at 
once.  

1) In your document, click where you want to paste the item. 
2) In the Clipboard, click the item you want to paste or, to paste everything, click 

Paste All.  
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Delete items from the Clipboard 
 Click the arrow on the right side of the item and click 

Delete (Figure 3). 
 Right-click the item you want to delete and click Delete. 
 Click Clear All to clear everything out of the Clipboard. 

 

 

 

 

 

Close the Clipboard 
 Click the X in the upper-right corner of the Clipboard 

pane.  
 Click the arrow next to the X and click Close (Figure 4). 

 

 

 

 

 

Set options for the Clipboard 
The options control a variety of Clipboard 
functions, such as when the Clipboard 
appears. 

 1) With the Clipboard open, 
click Options at the bottom of the 
pane (Figure 5).  

 

  

Figure 4 Closing Clipboard 

Figure 3 Deleting items from Clipboard 

Figure 5 Clipboard Options 
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Here's what each option does1:  

Option Description 

Show Office Clipboard 
Automatically 

Displays the Office Clipboard when you copy more than one 
item. 

Show Office Clipboard 
When CTRL+C Pressed 
Twice 

Displays the Office Clipboard when you press Ctrl+C twice. 

Collect Without Showing 
Office Clipboard 

Automatically copies items to the Office Clipboard without 
displaying the Clipboard task pane. When you select this 
option, the Clipboard will store content copied or cut from 
anywhere.  

Show Office Clipboard 
Icon on Taskbar 

Displays the Clipboard icon in the notification area of your 
Windows taskbar when the Clipboard is active. This option is 
on by default. 

Show Status Near Taskbar 
When Copying 

Shows the number of items you've collected in the bottom-
right corner of the Word window. This option is on by default. 

 

2.1.2 Paste Special 

Most users know how to use the Cut/Copy and Paste commands. They've been 
around since the early days of word processing and they're universal across almost 
every Windows application and Windows itself. When we use the copy – paste 
commands for the contents of a web page it pastes the text along with the embedded 
HTML code. This results in odd fonts, size and formatting of the text which requires 
a lot of effort to format it properly. The embedded code may also conflict with the 
settings you have used in the document. Sometimes, we may sometimes have 
something on our clipboard that we want to paste into our document in a special 
way, for example if we want to define the appearance in a certain way. In such cases 
it can be useful to know how to paste in an alternative way.  

  

                                                   
1 Source:http://office.microsoft.com/en-us/word-help/use-the-office-
clipboard-HA102850067.aspx  
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Therefore, we need a way to paste just the words we copied, just raw, unadul-
terated, code-free text. This is possible with the Paste Special command. In Microsoft 
Word 2010 the Paste options are available in the Clipboard group of Home tab. To 
access it click the bottom half of the button, the one with the down arrow. That'll 
produce a handful of Paste options, one of which is Paste Special (represented by a 
clipboard with a bold letter A. Steps to use Paste Special Command:  

1) Click the Home tab.  
2) Click the arrow under Paste in the Clipboard sub-tab.  
3) Click Paste Special.  

A dialog box like in Figure 6 will pop up: 

 

Figure 6: Paste Special Dialog Box2 

Select Unformatted text or Unformatted Unicode Text (the latter seems to work better 
when copying from a PDF) and click OK. Your copied text will paste in the same 
format as the text that surrounds it in your document. Keyboard shortcuts for Paste 
Special is Ctrl+Alt+V. 

  

                                                   
2 Source: http://blog.apastyle.org/apastyle/2010/09/computer-editing-tip-
paste-special.html  
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2.1.3 Formatting by Styles  

A style is a set of formatting instructions. When you apply a style, Word will format 
the text according to how that style has been defined. For example, you can use a 
style to make heading text large and bold. 

Word supports four types of styles: paragraph styles, character styles, table styles 
and list styles. Paragraph styles can include both font (e.g. size, type, colour, 
bold/italic) and layout (e.g. justification, line spacing) settings. Paragraph styles are, 
as might be expected, usually applied to whole paragraphs; however most can also 
be applied as character styles to selected text (when only the font settings are 
activated). The default paragraph style is called Normal. 

Character styles are used for changing the format of a particular piece of text within 
a paragraph. They contain only font settings. The default character style is called 
Default Paragraph Font. Table styles contain cell border, shading and alignment (as 
well as font) settings. List styles contain numbering (or bulleting) settings (+ font 
etc.) for each level in a list. 

There are many reasons for using styles, apart from consistency. Styles are simple to 
use and saves time for formatting. One paragraph style can be set to automatically 
change to another as you press the Enter key to end a paragraph. You can define 
your own styles and/or modify the ones provided by Microsoft Word. If you 
modify a style in a document, all paragraphs or occurrences of text using that style 
are immediately reformatted to reflect the new style. Finally, styles can be used to 
generate an Index and/or Table of Contents or Figures. 

Styles are associated with the document or template in which they are first defined. 
However it is possible to move or merge styles from one document or template into 
another one. 
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Using the Default Paragraph Styles  
All documents have pre-defined styles, derived from the template used by that 
document. As you will see, each paragraph can have its own style setting. 

1) Start up Word or create a new document (i.e. press <Ctrl n>) 
2) Save the file (press <Ctrl s>, type in a File name: of test styles then press 

<Enter> for [Save]) 

Note the buttons in the Styles group on the Home tab of the Ribbon: 

 

Figure 7: Styles Group 

There are many reasons for using styles, apart from consistency. Styles are simple to 
use and save you having to first turn on formatting and then turn it off again to 
return to normal. One paragraph style can be set to automatically change to another 
as you press the Enter key to end a paragraph. You can define your own styles 
and/or modify the ones provided by Microsoft Word. If you modify a style in a 
document, all paragraphs or occurrences of text using that style are immediately 
reformatted to reflect the new style. Finally, styles can be used to generate an Index 
and/or Table of Contents or Figures. 

Styles are associated with the document or template in which they are first defined. 
However it is possible to move or merge styles from one document or template into 
another one. 

 

Using the Default Paragraph Styles  
All documents have pre-defined styles, derived from the template used by that 
document. As you will see, each paragraph can have its own style setting. 

1) Start up Word or create a new document (i.e. press <Ctrl + n>). 
2) Save the file (press <Ctrl + s>, type in a File name: then press <Enter> for 

[Save]). 
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The buttons in the Styles group on the Home tab of the Ribbon shows three of the 
pre-defined paragraph styles. These derive from the template being used for the 
document - in this case the default template, normal.dotx. To use a style (e.g. 
Heading 1): 

1) Click on the Heading 1 button. 

2) Type in the words for your first heading - e.g. Exercise on Using Styles - the 
words will appear larger (14-point), emboldened, in blue letters and in a 
different font (Cambria). 

3) Press <Enter> - the style will automatically be reset to Normal. 

4) Type in a couple of lines of ordinary text (which appears in an 11-point Calibri 
font). 

Paragraph styles can be applied at any time to a particular paragraph - they do not 
have to be set in advance of typing. To demonstrate this: 

1) Make sure the typing position is within the paragraph - press <Backspace> if 
necessary. 

2) Move the mouse cursor over the buttons in the Styles group – the paragraph 
changes to match. 

3) Click on the More down arrow at the foot of the scroll bar attached to the styles 
– more styles appear. 

4) Choose Heading 2 - the whole paragraph will change to Cambria 13-point blue 
bold. 

5) Repeat steps 9 and 10 but choose Normal - the text will return to Calibri 11-
point. 

You can sometimes apply a paragraph style to some selected text: 

1) Select part of your normal text - a single word will suffice (double click on it). 

2) Click on the Heading 1 button - the text changes to Cambria 14-point blue bold. 

3) Press the <right arrow> key to move away from the selection - note that the 
paragraph style still shows as Normal on the button in the Styles group. 

4) Click on the Heading 2 button - the whole paragraph takes on the Heading 2 
style except for the word(s) using the Heading 1 character style! 
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Figure 8: Applying Styles 

Even if you select the whole paragraph and apply a new paragraph style, the words 
using the different character style remain different: 

1) Select the whole paragraph - the easiest way is to click three times anywhere 
within it. 

2) Click on the Normal button - again, only the paragraph style is effected (at least 
one word is still Cambria 14-point blue bold). 

3) To return the whole paragraph to normal, the current style settings must be 
cleared: 

4) With the whole paragraph selected, click on the More down arrow and choose 
Clear Formatting - the whole paragraph should return to Calibri 11-point. 

5) Press the <right arrow> key to release the selection. 

Hopefully, the above exercise has demonstrated the difference between a paragraph 
and character style. 

The Apply Styles Dialog Box  
Having to click on the More down arrow to access the different styles isn’t very 
friendly. In previous versions of Word, a toolbar button gave you a drop-down list. 
This was replaced in Word 2007 by the Apply Styles dialog box (though the old 
[Styles] button still works if you add it to the Quick Access Toolbar). 

 

 

To display the dialog box: 

1) Click on the More down arrow again but this 
time choose Apply Styles… - the dialog box 

appears (Figure 8). 

This box floats over both the text and the Ribbon, so you can position it wherever 
you choose. 

2) Drag the dialog box to your preferred position 

3) Click on the list arrow attached to the Style Name: box and choose Heading 2. 

4) Repeat step 3 setting the style of the current paragraph back to Normal 

The dialog box not only lets you select an existing style, it also offers an easy way to 
modify a style or create a new one of your own. 
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The Styles Task Pane 
1) Click on the Styles button (to the right of Modify) in the Apply Styles dialog box 

(or click on the Styles group arrow on the Ribbon) – a floating task pane 
appears (Figure 9). 

2) Double click in the blue heading area of the pane to anchor it to the right of 
your text. 

3) Turn on Show Preview at the foot of the pane to see the styles as they will appear 
in the document. 

Note that some styles are shown as paragraph styles (¶), some as character styles (a) 
and some as linked (paragraph and character ¶a) styles. The latter are the styles 
which can be applied to part of a paragraph (as a 
character style) as well as to the whole paragraph 
(as a paragraph style). Your myquote style is a 
paragraph style and cannot be used as a character 
style. To see this: 

1) Select a word in your first (normal) paragraph 
by double clicking on it. 

2) Click on the myquote style in the Styles task 
pane – the whole paragraph becomes a quote. 

3) Press <Ctrl z> for [Undo] to reset the original 
style of the paragraph. 

You can make myquote a linked style, if you want 
to be able to use it as a character style. To do this: 

1) Click on your quotation then on the Modify… 
button in the Apply Styles dialog box. 

2) Change the Style Type: to Linked (paragraph 
and character) then press <Enter> for [OK]. 

3) Check that Disable Linked Styles is turned off at 
the foot of the Style Pane. 

4) Repeat steps 1 and 2 –you can now apply the 
style to the single word. 

  
Figure 9: Styles Task Pane 
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The Styles task pane can also be used to modify styles and create new ones. To 
modify a style (e.g. normal): 

1) Move the mouse cursor over the Normal style in the task pane – the formatting 
details appear. 

2) Click on the list arrow attached to Normal and choose Modify… 

3) Change the line spacing to 1.5 Space – click on OK to close the Modify Style dialog 
box. 

Your text should is now one-and-a-half spaced, including your quotation as 
myquote is based on the normal style. Note that another option available via a 
style’s list arrow in the Task Pane is Update Normal to Match Selection which is another 
way of updating a style (as seen earlier in the notes).  

2.1.4 Editing Group 

Editing group has the commands to  

 Find and replace text and other data in your Word 2010 files 
 Select tool to select objects in the Word document. 

You can also use it to find and replace text, formatting, paragraph breaks, page 
breaks and other items. 

You can also use the Go To command to find a specific place in your document. 

Find text 
You can quickly search for every occurrence of a specific word or phrase. 

1) On the Home tab, in the Editing group, click Find (Figure 10)  
or press <CTRL+F>. The Navigation pane opens. 

2) In the Search Document box, type the text that you want to find.  

3) Click a result to see it in your document or browse through all the results by 
clicking the Next Search Result and Previous Search Result arrows. 

Note: If you make a change in your document and the search results disappear, click 
the down arrow in the Navigation pane to view the list of results. 

  

Figure 10: Editing Group
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Find other document elements 
To search for a table, a graphic, a comment, a footnote or an endnote or an equation, 
do the following: 

1) On the Home tab, in the Editing group, click 
Find or press <CTRL+F>. The Navigation pane 
opens (Figure 11). 

2) Click the arrow next to the magnifying glass 
and then click the option that you want.  

3) Click a result to see it in your document or browse through all the results by 
clicking the Next Search Result and Previous Search Result arrows. 

Find and replace text 
1) On the Home tab, in the Editing group, click Replace.  
2) In the Find what box, type the text that you want to search for and replace. 
3) In the Replace with box, type the replacement text. 
4) Click Find Next and then do one of the following: 

 To replace the highlighted text, click Replace. 
 To replace all instances of the text in your document, click Replace All. 
 To skip this instance of the text and proceed to the next instance, click Find 

Next. 

Use codes to find letters, formatting, fields or special characters 
Use the following codes to find letters, formatting, fields or special characters. Note 
that some codes work only if the Use wildcards option is turned on or off. 

Codes that work in the Find what box or Replace with box 

To find Type 

Paragraph mark (  )  ^p (doesn't work in the Find what box when the Use 
wildcards option is turned on) or ^13 

Tab character (  ) ^t or ^9 

ASCII character ^nnn, where nnn is the character code. 

ANSI character ^0nnn, where 0 is zero and nnn is the character code 

Em dash ( — ) ^+ 

En dash ( – ) ^= 

Caret character ^^ 

Manual line break (  ) ^l or ^11 

Column break ^n or ^14 

Page or section break ^12 (when replacing, inserts a page break) 

Figure 11: Find Dialog Box 
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To find Type 

Manual page break  ^m (also finds or replaces section breaks when the Use 
wildcards option is turned on) 

Nonbreaking space (  ) ^s 

Nonbreaking hyphen (
 ) 

^~ 

Optional hyphen (  ) ^- 

 

 

Codes that work in the Find what box only (when Use wildcards is turned off) 

To find Type 

Any character ^? 

Any digit ^# 

Any letter ^$ 

Picture or graphic (inline only) ^g 

Footnote mark ^f or ^2 

Endnote mark  ^e 

Field (when field codes are visible) ^d or ^19 or ^21 

Comment (when comments are 
inline) 

^a or ^5 

Section break ^b 

White space 
^w (any space or any combination of regular and 
nonbreaking spaces and tab characters) 

 

 

Code that works in the Replace with box only 

To find Type 

Microsoft Windows Clipboard contents ^c 
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Go to a specific page, table or other item 
You can search for and replace special characters and document elements such as 
tabs and manual page breaks. For example, you can find all double paragraph 
breaks and replace them with single paragraph breaks. 

1) On the Home tab, in the Editing group, click the arrow next to Find and then 
click Go To. 

2) In the Go to what box, click the type of item. 
3) Do one of the following: 

 To go to a specific item, type the appropriate identifying information for the 
item in the Enter item type box and then click Go To. 

 To go to the next or previous item of the specified type, leave the Enter box 
empty and then click Next or Previous. 

Use of select tool 
1) On the Home tab, in the Editing group, click Select.  
2) Do one of the following; 

 To select all of the text in the document, click Select All. 
 To select shapes that are hidden, stacked or behind text, click Select Objects 

and then draw a box over the shapes. 
 To select other objects (object: A table, chart, graphic, equation or other form 

of information. Objects created in one application, for example spreadsheets 
and linked or embedded in another application are OLE objects.), such as 
pictures, Smart Art graphics or charts, press and hold <CTRL> while you 
select the objects that you want. 

 To select text with similar formatting, click Select Text with Similar Formatting. 
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Tips for selecting shapes and objects 

To do this Do the following 

Select multiple objects.  
Press and hold <SHIFT> or <CTRL> 
while you click the objects.  

Select an object that is under other objects and 
cycle forward through the stack of objects.  

Select the top object and then press 
<TAB>.  

Select an object that is under other objects and 
cycle backward through the stack of objects.  

Select the top object and then press 
<SHIFT+TAB>.  

Select objects that are part of a group (group: 
A collection of objects that behave as one for 
the purpose of moving, resizing or rotating 
them. A group can be composed of multiple 
sets of groups.).  

Select the group and then do one of the 
following: 
To select one object, click the object. 
To select multiple shapes in a group, 
press and hold <SHIFT> or <CTRL> 
while you click the shapes. 

Cancel the selection of one object at a time.  
Press and hold <SHIFT> or <CTRL> 
while you click each object. 

 

2.1.5 Tables 

Tables can be used for displaying data in a compact format that is in columns and 
rows. Tables can be created easily and quickly in Word 2010. By default, tables are 
delimited with single lines (defining the rows, columns and cells), which print out. 
You can, however, reset the lines such that they do not print but still show as guide-
lines when you are editing the table in Word. 

Creating a Table 
As with many features in Word there are several different ways to create a table - 
you can: 

 Drag out a Table of the required size 
 Draw the table using the Draw Table option 
 Use a Quick Table for a pre-defined layout 
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Figure 12: Creating Table by Table Icon 

Figure 13: Creating by Table Command 

Using the Table Icon 
It is the easiest way to create a table just by dragging 
out of the required size table: 

1) Click where you want to insert the table - here, 
start at the top of a new blank document. 

2) Move to the Insert tab and click on the Table 
button - a table grid and other options appear 
(Figure 12). 

3) Create a 3 x 3 Table - drag the mouse cursor 
over the cells and click the mouse button when 
the table is the desired size (if you hold down 
the mouse button, the table is drawn when you 
release it). 

4) A skeleton table appears at the Insertion Point 
with three columns of equal width and height 
and the Table Tools Design and Layout tabs 
appear on the Ribbon. 

5) To move out of the table, press <Ctrl End> or 
use the down arrow key several times – the 
Table Tools tabs disappear, showing that you are no longer in the table. 

6) Press <Enter> for a blank line. 

Using the Command 
To create a table using the Insert Table command, 
carry out the following steps: 

1) Position the Insertion Point where the table is 
required - here, at the very end. 

2) Click on the Table button (on the Insert tab) 
and choose Insert Table... 

3) The Insert Table dialog box appears (Figure 13) - 
under Table size, enter the Number of co-
lumns: and Number of rows: required (here, 
set up 4 columns and 2 rows). 

The next set of options down, AutoFit behaviour, 
determine how the column widths are defined.  
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By default, column widths are set so that the table fills the page horizontally with 
equally-sized columns (as you saw with the first table 

The AutoFit to contents option fits the column width to the text as you type it.  

Remember dimensions for new tables can be used to make these values the default 
for future new tables. 

4) Here, change AutoFit behaviour to AutoFit to contents. 
5) Press <Enter> for [OK] and a very small skeleton table appears. 
6) Move on by pressing <Ctrl End> then <Enter> for a new line. 

Drawing By  
Word provides a Drawing Table facility which lets you to create a table by drawing 
it. Draw a table as follows: 

1) Click on the Table button and choose Draw Table - the cursor changes into a 
drawing pen. 

2) Position the drawing pen where you want to insert the table then hold down 
the left mouse button and drag out the outside border (as you do this, a dotted 
rectangle is displayed). 

3) Release the mouse button when the rectangle is the correct size - the table 
border appears and the Table Tools tabs are displayed. 

Next, draw the cells required: 

4) Repeat steps 2 and 3 to draw the columns and rows. 

5) If you make a mistake, press <Ctrl z> for [Undo] (or click on the Eraser button 
then on the unwanted line - click on Eraser again to turn it off and Draw Table to 
change the cursor back to a pen). 

Once you have finished drawing the inner lines, you may want the columns/rows 
to be of equal size: 

1) Move to the Table Tools Layout tab and note the buttons in the Cell Size groups. 

2) Use the Distribute Rows and/or Distribute Columns buttons to make them 
equally sized. 

3) Press <Ctrl End> to move out of your drawn table then <Enter> for a new line. 
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Figure 14: Adding Formula in Table 

Performing Calculations in a Table  
You can perform simple calculations in a table (it is assumed that you have already 
entered numerical data in the cells of the table): 

1) Press <Tab> to create a new 
row in your table. 

2) Press <Tab> again to move to 
the second column and type: 
Total: 

3) Press <Tab> to move to the 
last column then move to the 
Layout tab and click on the 
Formula button - the Formula 
dialog box appears (Figure 14). 

4) Press <Enter> for [OK] - the total appears in the cell you have entered the 
formula. 

Word does not claim to be a spreadsheet, so the total will not be updated 
automatically if one of the values changes. To test this out: 

1) Change the values in one or more cells - the total remains the same. 

2) To recalculate it, right click on the total figure and choose Update Field from the 
pop-up menu - the recalculated values appears. 

You can also create formulas like =SUM(LEFT) or =SUM(BELOW) by amending the 
formula accordingly. You can also perform other calculations, such as working out 
an average value. Try this here: 

1) Right click on the current calculation (Sum) and choose Edit Field… 

2) Click on the Formula… button to redisplay the Formula dialog box. 

3) Delete the current formula except for the = sign. 

4) Click on the list arrow attached to Paste Function: and choose AVERAGE. 

5) Type ABOVE to complete the function (i.e. =AVERAGE(above)). 

6) You can set up a Number format: if you want, but here press <Enter> for [OK]. 

7) End by changing Total to Average in the second column. 

Tip: For a formula which works on certain cells only, use the cell references. The 
rows in a table are denoted by numbers, the columns by letters - in exactly the same 
way as Excel. Examples of valid formulae are: =SUM(A2,A3,A4), =SUM(A2:B4), 
=SUM(2:2) (i.e. all cells in the second row), =SUM(C:D) (all the cells in both the third 
and fourth columns). 
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Figure 15: Convert Table to Text Dialog box 

Header Rows  
Where you have a table which stretches over more than one page, you can set up a 
row to act as a Header. This then appears at the top of each page. You haven't got 
any long tables here, but the effect can be seen if you force a table to cross a page 
break. 

1) Move the Insertion Point into the top row in your table of expenses. 

2) Now click on the Repeat Header Rows button in the Data group on the right of the 
Layout tab. 

3) Move the Insertion Point to immediately above your table. 

4) Press <Enter> until the table splits across a page - you should find that the 
heading row is shown on both pages. 

5) Having seen the effect, press <Ctrl z> to [Undo] the excess empty paragraphs. 

Note: If you want more than one row to be used as the header, select them before 
issuing the Header Rows Repeat command. 

Converting Text to a Table  
Any tab-separated text can be converted into a table using the [Convert] button in 
the Data group. This offers two options: Text to Table... 
and Table to Text.... The latter can be used to convert an 
existing table into tab-separated text. 

1) Press <Ctrl End> to move to the end of your 
document then <Enter> for a new line. 

2) Type 1 (press <Tab>) 2 (<Tab>) 3 (<Tab>) 4 (this time 
press <Enter>). 

3) Type 5 (press <Tab>) 6 (<Tab>) 7 (<Tab>) 8 (<Enter>). 

4) Drag through the two rows to select them then move 
to the Insert tab and click on the Table button and se-
lect Convert Text to Table... - the dialog in the box on 
the right appears (Figure 15). 

Note the settings here - paragraph or comma-separated 
text can also be converted into a table (indeed, any 
specified character can be used to denote the column breaks). 

5) Press <Enter> for [OK] - the text is converted into a table. 
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Figure 16: Text Separator for Table to Text 

Figure 17: Caption 

To change a table into text (use the current table for 
practice): 

1) Move to the Layout tab then click on the Convert to 
Text button - the dialogue of Figure 16 appears. 

2) Set the options as necessary - here, change Separate 
text with to Paragraph Marks. 

3) Press <Enter> for [OK] - the table is converted into 
text, one value per line. 

Numbering Tables, Cross-Referencing 
and Creating an Index 
If you are typing a long document, like a book or thesis, you may well want to create 
an Index of Tables. Word has the facility to do this - it works just like when you 
create a Table of Contents. In order to make use of this facility, the table headings 
must be created using a Caption. This is available from the References ribbon. 

1) Press <Ctrl Home> to move to the start of 
your document. 

2) Press <Enter> for a new line (note that a 
blank line is added before your table, not 
in it). 

3) Click on the References tab at the top and 
then Insert Caption in the Captions group on 
the ribbon, the dialog in Figure 17  
appears. 

4) Under Options change the Label to Table, using the list arrow provided. 

5) Click after Table 1 in the Caption: text box, add a space and then type Using the 
Table Icon. 

6) Press <Enter> for [OK] (the caption is added) then <Enter> again for a new line. 

7) Move the Insertion Point down to the blank line above your second table - press 
<Enter>. 

8) Repeat steps 3 to 6, this time typing Using the Insert Table Command. 

9) Repeat steps 7 and 8 for your third table typing Drawing a Table. 

10) Now press <Ctrl Home> to move to the start of your document. 

11) Click on the References tab, then Insert Table of Figures in the Captions group on 
the ribbon and press <Enter> for [OK] when the Table of Figures window 
appears. 
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An Index of Tables should appear at the top of your document. 

You can reference a table in your text (so that the numbering changes automatically 
if the table itself is renumbered) using a cross-reference: 

1) Move down to the blank line below your first table. 

2) Type in, then click on the References tab followed by Cross-reference in the 
Captions group on the ribbon. 

3) Change the Reference type: to Table. 

4) Change Insert reference to: to Only label and number. 

5) Press <Enter> for [Insert] then <Esc> for [Close]. 

6) Continue typing above, note how ... 

Activity 4 

1) Enlist the Advanced Features of MS Word 2010. 

___________________________________________________________ 

___________________________________________________________ 

___________________________________________________________ 

 

2) What is the purpose of clip board? What are the different ways of using 
clipboard? 

______________________________________________________________________ 

______________________________________________________________________ 

3) Differentiate between Paste Special and Format painter. 

-____________________________________________________________________ 

-____________________________________________________________________ 

-____________________________________________________________________ 

-____________________________________________________________________ 

-____________________________________________________________________ 

 

4) What are the different uses of Styles Group?   

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 
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______________________________________________________________________ 

 

5) Define Editing group. Enlist the different used of commands in the Editing 
group.  

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________  

______________________________________________________________________ 

______________________________________________________________________ 

 

6) How can we present data in a word document in an organized manner? What 
utility is available to perform calculations on data? 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

 

7) What are the different way of creating tables and when these different methods 
are used? 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 
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______________________________________________________________________ 

Activity 5 

 

1) Write steps to perform the following tasks. 

 Use clipboard to: 
 Paste more than one item at the same time.  
 Add and delete items in the clipboard 
 Define different settings for clipboard 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

 

2) Using Paste Special to add pate contents from the webpage and from other 
sources. 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

 

3) Use Styles for format document for four levels of headings i.e., Level 1, Level 2, 
Level 3 and Level 4. 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 
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 Search  
 Paragraph marks 
 Page break 
 Column break 
 Section break 
 Specific page  
 Specific table  

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 
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Task 

Task 2 

The student should look upon the task as a test of knowledge, 
management skills and communication skills. When you write an 
answer asked in the task, you are indicating your knowledge to 
the teacher:  

 Your level of understanding of the subject 
 How clearly you think 
 How well you can reflect on your knowledge & experience 
 How well you can use your knowledge in solving problems, explaining 

situations and describing organizations and management 
 How professional you are and how much care and attention you give to what 

you do. 

Perform the following tasks and write down the steps how you have per-
formed these tasks: 

1) Create custom styles in Microsoft Word. 

2) Paragraph styles - Modify existing paragraph styles. 

3) Styles – create new paragraph styles. 

4) On a new document, create the basic table (with 5 columns and 4 rows) as 
shown below: 

 
5) Add your own details at the end of the table (press TAB key to insert an extra 

line at the end of the table). 

6) Change the border lines, shading and row height to create a table similar to the 
example shown below: 
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7) On a new document, create the following form using a table: 

 
 

8) Create a document describing the usefulness of word processing software with 
4 levels of headings in the text and appropriate screen shots with suitable 
captions using insert caption command. Then 

9) Insert table of content using the table of content command 

10) Insert the list of figures using the command provided for it in the ms word. 

11) List the detailed steps how you have completed this particular task. 

 

If there are any questions, please do not hesitate to contact  

Dr. Shafiq ur Rehman via e-mail: shafiqurrehman1@yahoo.com  
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3 Presentation Software Important Features (Chapter 7) 

Learning Objectives 

Upon successful completion of this chapter, you will be able to 

 Understand about the useful Practices of MS PowerPoint like adding anima-
tions, insert multimedia clips / content in the slides, creating animation using 
motion path, understand the concept of “Master Slide”, add action buttons. 

3.1 Useful Practices of MS PowerPoint 

Microsoft PowerPoint, usually just called PowerPoint, is a commercial presentation 
program developed by Microsoft. It is part of the Microsoft Office suite and gener-
ally uses a graphical approach to presentations in the form of slide shows that 
accompany the oral delivery of the topic. The main purpose of MS PowerPoint is to 
enable the user to create dynamic, informational slides through the use of text, 
graphics and animation. Slide presentations created with the software are often 
displayed on projection screens for business, training or educational presentations, 
although they can be distributed as stand-alone files. 

With the new release of Microsoft Office 2010, many advanced features were added 
in PowerPoint 2010. Following is a list of several new features in PowerPoint 2010: 

1) Embed and edit video from within PowerPoint. These embedded videos be-
come part of your PowerPoint presentation; you don’t have to manage addi-
tional files when sharing with others. 

2) Use new and improved picture editing tools. You can use picture editing tools 
including versatile artistic effects and advanced correction, colour and cropping 
tools, to fine-tune every picture in your presentation to look its absolute best. 

3) Work together more successfully. If you are one of the many people who work 
with others on presentations and projects, PowerPoint 2010 is the perfect tool 
for you. The new added co-authoring capabilities to edit the same presentation 
allow you to work with people in different locations at the same time. You can 
even communicate as you work, directly from PowerPoint  

4) Access and share your content from more places. Your ideas, deadlines, pro-
jects and work emergencies don’t always occur conveniently when you are at 
your desk. Fortunately, you now have the power to get things done when and 
where you need to, from the Web with Microsoft PowerPoint Web App or even 
from your smart phone with Microsoft PowerPoint Mobile. 
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3.1.1 Add Animations in a Presentation 

Animations can be applied to every object on a slide – including titles and other text 
boxes. Many objects can even have animation applied to different components, for 
example each shape in a SmartArt graphic, each paragraph in a text box and each 
column in a chart. Animations can be applied to three separate ‘events’ for each 
object: 

 Entrance – how the object arrives on the slide 
 Emphasis – an effect to focus attention on an object while it is visible 
 Exit – how the object disappears from the slide 

 

Figure 18: Effect Option 

To apply an animation effect, choose the object or objects to be animated, then 
choose Animation Styles or Add Animation from the Animations toolbar. 
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To add an animation effect to an object, do the following: 

1) Select the object that you want to animate. 

2) On the Animations tab, in the Animation group, click on  and then select the 
animation effect that you want. 

 

Figure 19: Animations 

Apply multiple animation effects to a single object  
To apply multiple animations onto the same object, do the following:  

1) Select the text or object that you want to add multiple animations.  

2) On the Animations tab, in the Advanced Animation group, click Add Animation.  

 

Figure 20: Multiple Animations 

View a list of animations currently on the slide  
You can view the list of all the animations on the slide in the 
Animation task pane. The Animation task pane shows important 
information about an animation effect, such as the type of effect, 
the order of multiple effects in relation to one another, the name of 
the object affected and the duration of the effect.  

1) To open the Animation task pane on the Animations tab in the 
Advanced Animation group click Animation Pane. 

2) In the Task pane, numbers indicate the order in which the ani-
mation effects play. The numbers in the task pane correspond 
to the non-printing numbered tags that are displayed on the 
slide.  

3) Timelines represent the duration of the effects.  

4) Icons represent the type of animation effect. In this example, it is an Exit effect.  

Figure 21: Animation Preview
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5) Select an item in the list to see the menu icon (down arrow) and then click the 
icon to reveal the menu.  

Set the effect options, timing or order for an animation 
1) To set the effect options on the Animations tab, in the Animation group, click the 

arrow to the right of Effect Options and click the option that you want. 

2) You can specify the start, duration or delay timing for an animation on the Ani-
mations tab. 

 To set the start timing for an animation, in the Timing group, click the arrow 
to the right of the Start menu and select the timing that you want. 

 To set the duration of how long the animation will run, in the Timing group, 
enter the number of seconds that you want in the Duration box. 

 To set a delay before the animation begins, in the Timing group, enter the 
number of seconds that you want in the Delay box. 

 To reorder an animation in the list, in the Animation task pane, select the ani-
mation that you want to reorder and on the Animations tab, in the Timing 
group, under Reorder Animation, either select Move Earlier to make the anima-
tion occur before another animation in the list or select Move Later to make 
the animation occur after another animation in the list.  

Test your animation effect  
After you add one or more animation effects, to validate that they work, 
do the following:  

1) On the Animations tab, in the Preview group, click Preview.  

Advanced Animation Timeline 
With the advanced Timeline you can see 
the duration, start and end for each 
animation in relation to the other ani-
mations. For advanced animation needs 
the with previous setting is utilized more 
and the animation start position and 
duration are adjusted with the Advanced 
Timeline (as example when an over-
lapping animation is needed).  

To see the Advanced Timeline, click any 
animation and choose Show Advanced 
Timeline.  
  

Figure 22: Animation Timeline 
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To use the animation painter 
The animation painter works much like the Format Painter which has been part of 
the Microsoft Office suite of programs for a long time. 

The animation painter allows the creator of the presentation to copy the animation 
effects of one object (and all the settings applied to that animated object), to another 
object (or many objects) with a single click of the mouse on each new object. This 
feature is a real time saver 

a) First Steps for Using the Animation Painter 

1) Select the slide which contains the animation you wish to copy. 
2) Click on the Animations tab of the ribbon. 
 

b) Copy Animation to ONE Object 

1) Click on the object that contains the desired animation. 
2) In the Advanced Animation section of the ribbon, click on the Animation Painter 

button (Figure 23). Note that the mouse cursor now changes to an arrow with a 
paint brush. 

3) Click on the object to which you wish to apply this same animation. 

This animation and all its settings have now been applied to the new object. 

c) Copy Animation to SEVERAL Objects 

1) Click on the object that contains the desired animation. 
2) In the Advanced Animation section of the ribbon, double click on the Animation 

Painter button (Figure 23).  

 

Figure 23: Advance Animation 

3) Note that the mouse cursor now changes to an arrow with a paint brush. 
4) Click on the first object to which you wish to apply this same animation. 
5) This animation and all its settings have now been applied to the new object. 
6) Continue to click on all objects that require the animation. 
7) To turn the animation painter off, click the Animation Painter button again. 

  



56 

3.1.2 Insert multimedia clips / content in the slides 

You can insert one or more video clips — that is, movies — into any slide. You 
might want to play a video quote from your product manager, for example or run a 
short documentary movie for a fund-raising event. You could even create a video 
for product tutorials and educational materials. 

Most of the movie clips stored in the Clip Organizer are simply animated .gif files, 
small files that contain an animated sequence of images. If you imported your own 
movie files into the Clip Organizer, you will find them there, too, generally stored in 
.avi format. You might be able to find additional movie clips on your network, 
intranet or the Internet. 

To insert a movie into a slide, follow these steps: 

1) Display the slide in which you want to add a video clip. 
2) On the Insert menu, point to Movies and Sounds and then click Movie from Clip 

Organizer. 

You can now browse the Clip Organizer for a movie clip. PowerPoint will open the 
Clip Art task pane and will select the Movies option in the Results should be drop-
down list. You can use the Clip Art task pane to locate a video clip stored on your 
computer or on the Office Online Web site.  

3) Click the movie you want to add to your slide. 

Insert a movie from a file 
You can insert a movie from a movie file on a local disk, a shared network location 
or an Internet site. 

1) On the Insert menu, point to Movies and Sounds and then click Movie from File.  
2) Select the movie file in the Insert Movie dialog box and then click the OK button. 

If you selected a movie clip in animated .gif format, the animation will run 
automatically the entire time the slide is displayed in a slide show. If, however, you 
selected a movie in another format (such as .avi), PowerPoint will display a message 
box letting you choose when the movie will play. 

To have the movie play automatically when the slide is displayed in a slide show, 
click the Automatically button. 

To have the movie play only after you click the movie image, click the When Clicked 
button. PowerPoint will then add the clip to your slide. 
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Insert a sound 
Sound effects, such as music and voice recordings, can add another level of pro-
fessionalism to your slide presentations. Music is an effective way to introduce or 
end a presentation and it gives your audience something to listen to as they enter 
and leave the presentation room. You could play a movie theme song as back-
ground music for several slides or play a voice recording that contains advertising 
slogans to insert on a single slide, for example. 

To add a sound clip to your slide show, perform the following steps: 

1) Display the slide to which you want to add sound. 
2) Use one of the following three methods to insert the sound clip:  

 To browse through the Clip Organizer for a sound clip, on the Insert menu, 
point to Movies and Sounds and then click Sound from Clip Organizer. 

PowerPoint will display the Clip Art task pane and will select Sounds in the 
Results Should Be drop-down list. You can use the Clip Art task pane to locate a 
sound clip stored on your computer or on the Office Online Web site. 

 To insert a sound clip from an existing sound file on a local disk, a shared 
network location or an Internet site (if you haven’t imported the file into the 
Clip Organizer), on the Insert menu, point to Movies and Sounds and then click 
Sound from File. 

The Insert Sound dialog box will appear. Select the sound file that you want 
and then click the OK button. 

 To record your own sound clip (you must have a microphone attached to 
your computer) and add it to the slide, on the Insert menu, point to Movies and 
Sound and then click Record Sound. 

 PowerPoint will display the Record Sound dialog box. Use the controls in this 
dialog box to record your sound and then click the OK button. 

The sound will play during a slide show only when you click the sound icon. (You 
can modify this behaviour using the Custom Animation task pane.) 

 To have the clip play automatically when the slide is displayed in a slide 
show, click the Automatically button. 

 To have the clip play only after you click the sound icon, click the When 
Clicked button. 
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3.1.3 Creating animation using Motion Path 

Apply or draw a motion path 
1) In normal view, display the slide that has the text or objects you want to create 

a motion path for. 

2) Select the text item or object you want to animate. For text items, you can select 
a placeholder or paragraph (including a bullet). 

3) If the Custom Animation task pane is not displayed, on the Slide Show menu, 
click Custom Animation. 

4) In the Custom Animation task pane, click , then  and do one of 
the following: 

Apply a preset motion path 
1) Click a preset path or click More Motion Paths to choose from more options. 

Create a custom motion path 
1) Point to Draw Custom Path and then do one of the following:  

 Click Freeform to draw a path with both curved and straight segments. 
Drag to draw freehand shapes; click and move the mouse to draw straight 
lines. 

 Click Scribble and drag to draw a path that looks more like it was drawn 
with a pen or to create smooth curves. 

 Click Line and drag to draw a straight path. 

 Click Curve and click where you want the curved path to start and then 
continue to move the mouse and click wherever you want to add a curve. 

2) Do one of the following:  

 If you want to end the freeform (freeform: Any shape that you draw by using 
the Curve, Freeform and Scribble tools. Freeform shapes can include straight 
lines and freehand curves. They can be drawn opened or closed and can be 
edited by using the drawing tools.) or curved path and leave it open, double-
click at any time. 

 If you want to end a line or scribbled path, let go of the mouse button. 
 If you want to close a shape, click at its starting point. 

Tip: To make the path mimic an exit effect, set effect options to fade or hide the item 
after the animation plays or draw the motion path off the slide. 
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Copying Motion path using Animation painter 
In Microsoft PowerPoint 2010, you can quickly and easily copy animations from one 
object to another using the Animation Painter. 

 

Figure 24 Animation Motion Path 

Figure 24: An example where the Motion Path animation from the blue square is 
“painted” or copied onto the green circle. 

To copy an animation, do the following: 

1) Select the object with the animations that you want to copy. 

2) On the Animations tab, in the Advanced Animation group, click Animation Painter.

 

Figure 25: Animation Painter 

3) Your cursor will change to appear like this:  

4) On the slide, click the object to which you want to copy the animations. 
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3.1.4 Slide Master View 

Slide Master View is a special mode in PowerPoint that allows you to modify slides 
and slide layouts in your presentation. Slide Master View can be used to make 
changes to every slide in your presentation. It helps in modifying individual slide 
layouts, creating new layouts and saving custom layouts. 

You may have noticed that when you select a different theme in PowerPoint, it 
rearranges the text on your slides and adds shapes to the background. That's be-
cause each theme has built-in slide layouts and background graphics. You can edit 
these layouts with a feature called Slide Master View. Once you learn how to use 
Slide Master View, you'll be able to customize your entire slide show with just a few 
clicks. 

Slide Master View is a special feature in PowerPoint that allows you to quickly mo-
dify the slides and slide layouts in your presentation. From there, you can edit the 
slide master, which will affect every slide in the presentation. You can also modify 
individual slide layouts, which will change any slides using those layouts. For 
example, suppose you find a theme you like, but you don't like the slide layouts. 
You could use Slide Master View to customize the layouts exactly the way you 
want. 

In Slide Master View, the Slide Master tab will appear first on the Ribbon, but you'll 
still be able to access commands on different tabs as normal. 

 

3.1.4.1 Formatting Master Slides in PowerPoint 2010 

Benefits of formatting master slides: 

 You can define the formatting for all slides at once, so the format will be 
consistent on all slides. 

 Any changes you make to the master slides will be automatically applied to 
all slides in the presentation. 

Open the Slide Master 
1) From the menu ribbon, select the View tab > Slide Master. 

 

Figure 26: View Option 

2) A new Slide Master tab will automatically appear. 
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Formatting Text 
1) Click on the master title style to select it.  

2) From the Slide Master tab, select the Fonts dropdown in the Edit Theme area.  

 

Figure 27: Slide Master Option 

3) Select the desired font, font style, font size, effects and colour. 

4) Click OK when you have finished selecting the font attributes for the title style. 

5) Click elsewhere on the slide to deselect the title style and view the font for-
matting. 

6) Repeat the steps as needed until you are satisfied with the appearance of the 
title style. 

7) Select each text style and follow steps 2 - 6 to format the appearance of the text. 

8) To change the bullets for each level of text, click on the text to select it and from 
the Home tab, expand the Bullets and Numbering menus.  

 

Figure 28: Setting Slide Master 

 

Tip: You can also double click to highlight existing bulleted or numbered 
list and a floating font window will appear.  

 Figure 29: Font Style 
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Moving and Resizing Text Areas 
1) Click on a text area. A border appears with resize handles.  

2) To resize the text area, click and drag a resize handle while keeping the mouse 
clicked. A dotted line shows the new size of the area.  

3) To move the text area, move the mouse pointer over the text area. The mouse 
pointer becomes a four-headed arrow. Click and drag the text area to a new 
location while keeping the mouse clicked. 

Working with Footers and Special Placeholders 
The Slide Master contains placeholders for date/time, slide number and footer. 
These can be moved around, resized, reformatted and turned on or off.  

1) In the menu ribbon, select the Insert tab > Header and Footer (Figure 30). 

 

Figure 30: Header & Footer 

2) The Header and Footer box appears (Figure 31). 

 

Figure 31: Header & Footer Dialog Box 

3) Click on the Slide number check box if you want the slides to be numbered. 

4) Type text in the Footer box if you want footer text on each slide.  

5) Click the Don't show on title slide check box if you do not want the placeholders 
to appear on the title slides. 
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Tip: Fill or picture to select a gradient, texture, pattern or picture for your 
background. 

1. You can preview your color selections before you apply simply by 
mouse over your selection. 

2. Click to apply the background selection to the slide master.  
Return to Normal view 

1. After defining your slide master formats, return to the normal view so 
you can edit individual slides by selecting the Slide Master tab > Close 
Master View from the ribbon.  

6) By default, the date/time does not appear even though the placeholder is 
turned on. This is because Fixed is the default setting and the Fixed box is blank. 
To make the date/time appear, type the date in the Fixed box or click Update 
automatically to set up an automatic date/time on each slide. Click the drop 
down menu to select the desired date/time format. 

7) Click Apply to All to apply the footers and placeholders to all slides. 

Changing the Background 
1) From the menu ribbon, select the Slide Master tab > Background > Background 

Styles dropdown menu. The Background window appears. 

 

Figure 32: Format Slide Master 

2) Select a predefined colour.  
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3.1.4.2 Best practice for creating and working with slide masters 

It is a good idea to create a slide master before you start to build individual slides, 
rather than after. When you create the slide master first, all of the slides that you 
add to your presentation are based on that slide master and the associated layouts. 
When you begin making changes, be sure to make them on the slide master. 

If you create a slide master after you build individual slides, some of the items on 
the slides may not conform to the slide master design. You can override some of the 
slide master customizations on individual slides by using the background and text 
formatting features, but others (such as footers and logos can be modified only in 
Slide Master view. 

Create or customize a slide master 
1) Open a blank presentation and then, on the View tab, in the Master Views group, 

click Slide Master. 

2) When you open Slide Master view, a blank slide master with the default, asso-
ciated layouts appears.  

Note: In the slide thumbnail pane, the slide master is the larger slide image and 
the associated layouts are positioned beneath the slide master. 

3) To remove any of the built-in slide layouts that accompany the default slide 
master, in the slide thumbnail pane, right-click each slide layout that you want 
to delete and then click Delete Layout on the shortcut menu. 

4) To set the page orientation for all of the slides in your presentation, on the Slide 
Master tab, in the Page Setup group, click Slide Orientation and then click 
either Portrait or Landscape. 

5) On the File tab, click Save As. 

6) In the File name box, type a file name. 

7) In the Save as type list, click PowerPoint Template and then click Save. 

8) On the Slide Master tab, in the Close group, click Close Master View. 
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3.1.5 Add action buttons 

Action buttons are built-in button shapes that you can add to your presentation and 
then assign an action to occur upon the click of a mouse or when someone mouses 
over the button. You can also assign actions to clip art, pictures or the text in a 
SmartArt graphic. The idea is that when you deliver your presentation, you can click 
or mouse-over an action button to: 

 Go to the next slide, the previous slide, the first slide, the last slide, the most 
recent slide viewed, a specific slide number that you specify, a different 
Microsoft Office PowerPoint presentation or a Web page 

 Run a program 
 Run a macro 
 Play a sound 

Insert an action button on a single slide 
1) Select the slide you want to place a button on. 

2) On the Slide Show menu, point to Action Buttons and then select the button you 
want — for example, Home, Back or Previous, Forward or Next, Beginning, End or 
Return. 

3) Click the slide. 

4) In the Action Settings dialog box, set the actions that you want on the Mouse Click 
and Mouse Over tabs and then click OK. 

For example, to open another document or play a movie when the button is clicked 
during the slide show, on the Mouse Click tab, click Hyperlink to and then in the drop-
down list, select Other File. In the Hyperlink to Other File dialog box, navigate to the file 
you want to open and then click OK twice. 
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Insert an action button on every slide 
If you're using one slide master (slide master: The main slide that stores information 
about the theme and layouts of a presentation, including the background, colour, 
fonts, effects, placeholder sizes and positions.), you can insert an action button on 
the master and the button is available throughout the presentation. If you are using 
multiple slide masters (such as when you have applied more than one design tem-
plate to your presentation), you must insert the action button on each master. 

1) On the View menu, point to Master and then click Slide Master. 

2) On the Slide Show menu, point to Action Buttons and then select the button you 
want — for example, Home, Back or Previous, Forward or Next, Beginning, End or 
Return. 

3) Click the slide master. 

4) In the Action Settings dialog box, set the actions that you want on the Mouse Click 
and Mouse Over tabs and then click OK. 

For example, to open the previous slide when the button is clicked during the slide 
show, on the Mouse Click tab, click Hyperlink to and then in the drop-down list, select 
Previous Slide. Click OK. 

5) Click Close Master View on the Master View toolbar (toolbar: A bar with buttons 
and options that you use to carry out commands. To display a toolbar, press 
<ALT> and then <SHIFT F10>). 

3.1.5.1 Assign an action to a built-in button or picture 

Some examples of built-in action button shapes that you can find in the Shapes 
gallery include right and left arrows and commonly understood symbols for going 
to next, previous, first and last slides and for playing movies or sounds and more.  

 

Figure 34: Action Button 
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3.1.5.2 Add an action button and assign an action 

1) On the Insert tab, in the Illustrations group, click Shapes and then under Action 
Buttons, click the button that you want to add. 

2) Click a location on the slide and then drag to draw the shape for the button. 

3) In the Action Settings dialog box, do one of the following: 

 To choose the behaviour of the action button when you click it in Slide Show 
view, click the Mouse Click tab. 

 To choose the behaviour of the action button when you move the pointer 
over it in Slide Show view, click the Mouse Over tab. 

4) To choose the action that will take place when you click or move the pointer 
over the action button, do one of the following: 

 To use the shape without a corresponding action, click None. 
 To create a hyperlink, click Hyperlink to and then select the destination (for 

example, the next slide, the previous slide, the last slide or another Power-
Point presentation) that you want the hyperlink action to go to.  

Note: To link to a file created by another program, such as a Microsoft Office 
Word or Microsoft Office Excel file, in the Hyperlink to list, click Other File. 

 To run a program, click Run program, click Browse and then locate the pro-
gram that you want to run. 

 To run a macro (macro: An action or a set of actions that you can use to 
automate tasks. Macros are recorded in the Visual Basic for Applications 
programming language.), click Run macro and then select the macro that you 
want to run.  

Note: The Run macro settings are available only if your presentation contains a 
macro. When you save the presentation, you must save it as a PowerPoint 
Macro-enabled Show.  

If you want the shape that you chose as an action button to perform an action, click 
Object action and then select the action that you want it to perform. 

 To play a sound, select the Play sound check box and then select the sound that 
you want to play. 

 Click Ok. 

  



68 

3.1.5.3 Add a picture or clip art and assign an action 

1) On the Insert tab, in the Illustrations group, do one of the following: 

 Click Picture and then in the Insert Picture dialog box, locate the picture that 
you want to add and then click Insert. 

 Click Clip Art and then in the Clip Art pane, locate and then click the picture 
that you want to add. 

2) Click the picture or clip art that you added and then on the Insert tab, in the 
Links group, click Action. 

3) In the Action Settings dialog box, do one of the following: 

 To choose the behaviour of the picture or clip art when you click it in Slide 
Show view, click the Mouse Click tab. 

 To choose the behaviour of the picture or clip art when you move the pointer 
over it in Slide Show view, click the Mouse Over tab. 

4) To choose the action that will take place when you click or move the pointer 
over the picture or clip art, do one of the following: 

 To use the shape without a corresponding action, click None. 
 To create a hyperlink, click Hyperlink to and then select the destination (for 

example, the next slide, the previous slide, the last slide or another Power-
Point presentation) that you want the hyperlink action to go to. 

 To run a program, click Run program, click Browse and then locate the pro-
gram that you want to run. 

 To run a macro (macro: An action or a set of actions that you can use to 
automate tasks. Macros are recorded in the Visual Basic for Applications 
programming language.), click Run macro and then select the macro that you 
want to run. 

 If you want the picture or clip art to perform an action other than what is 
listed, click Object action and then select the action that you want it to per-
form. 

 To play a sound, select the Play sound check box and then select the sound that 
you want to play. 
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Activity 6 

Perform the following task and enlist the steps involved in 
performing the task. 

1) Create a PowerPoint presentation. 
2) Add animation for text and pictures at least 75% of the time. 
3) Add sound to Slide Transitions at least 75% of the time. 
4) Insert, Format and Change a Chart at least 75% of the time. 
5) Insert a Table at least 75% of the time. 
6) Apply Quick Styles to a Table. 
7) Insert a Column into a table & Merge cells. 
8) Format text alignment and orientation in a table. 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 
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Activity 7 

Perform the following task and enlist the steps involved in 
performing the task. 

1) Create a PowerPoint presentation. 
2) Open Slide Master view. 
3) Insert a picture or shape on all slides. 
4) Customize an existing slide layout.  
5) Change the font of the master title style on the slide master. 
6) Create a new slide layout and add at least one placeholder. 
7) Review the presentation in Normal view to see the changes. 
8) Save the theme so you'll be able to use the custom layouts in other presenta-

tions. 
9) Create and Modify Shapes at least 75% of the time 
10) Create an Action button at least 75% of the time 
11) Edit the Action Settings 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 
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Task 

Task 3 

The student should look upon the task as a test of knowledge, 
management skills and communication skills. When you write an 
answer asked in the task, you are indicating your knowledge to 
the teacher:  

 Your level of understanding of the subject. 
 How clearly you think. 
 How well you can reflect on your knowledge & experience. 
 How well you can use your knowledge in solving problems, explaining 

situations and describing organizations and management. 
 How professional you are and how much care and attention you give to what 

you do. 

Perform the following tasks and write down the steps how you have performed 
these tasks: 

1) Apply headers, footers and page numbers to handout masters. 
2) Apply Quick Styles to the handout masters at least 75% of the time. 
3) Print handouts with 1 or more slides per page at least 75% of the time. 
4) Change the notes page to have Landscape orientation at least 75% of the time. 
5) Add Text to the Notes Page at least 75% of the time. 
6) Access the slide master view. 
7) Identify masters and layouts in use. 
8) Apply global (theme master) changes. 
9) Apply local (theme layout) changes. 
10) Open the Animation Pane. 
11) Open the Animation Pane. 
12) Open the Animation Pane. 
13) Animate an Object (SmartArt/chart etc.). 
14) Edit/reorganise an animated sequence. 
15) Edit/reorganise an animated sequence. 
16) Change the animation order. 
17) An audio clip icon represents any audio files you include. The new default 

format for audio is AAC rather than the previous .wma. Audio can start 
automatically, on click or as part of an animated sequence. 

18) Audio can be linked or embedded. 
19) Embedded files inflate the size of the PowerPoint file. 
20) Linked files must put into a folder structure which accompanies the presentation.
21) Play audio over several slides. 
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4 Computer Network Fundamentals (Chapter 9) 

Learning Objectives 

Upon successful completion of this chapter, you will be able to 

 Know different types of computer network, such as LAN, MAN, WAN, 
Internet 

 Know different network topologies 
 Know types of network topologies 

4.1 Introduction 

A computer network is a system of interconnected computers and peripheral de-
vices. For example, it may connect computers, printers, scanners and cameras. A 
computer network consists of a collection of computers, printers and other 
equipment that is connected together so that they can communicate with each 
other. Figure 35 gives an example of a network in a school comprising of a local 
area network or LAN connecting computers with each other, the internet and 
various servers. In a network, computers can exchange and share information 
and resources. A computer network may operate on wired connections or wire-
less connections. 

 

Figure 35: Computer Network 

When two or more networks are linked or connected and are able to communi-
cate with one another using suitable hardware and software, it is called an inter-
network. 
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4.2 Types of Computer Network according to network configuration 

Broadly speaking, there are two types of network configuration, peer-to-peer net-
works and client/server networks.  

Peer‐to‐peer networks are more commonly 
implemented where less than ten com-
puters are involved and where strict secu-
rity is not necessary. All computers have 
the same status, hence the term 'peer' and 
they communicate with each other on an 
equal footing. Files, such as word pro-
cessing or spreadsheet documents, can be 
shared across the network and all the com-
puters on the network can share devices, 
such as printers or scanners, which are connected to any one computer. 

Client/server  networks are more suitable 
for larger networks. A central computer or 
'server', acts as the storage location for files 
and applications shared on the network. 
Usually the server is a higher than average 
performance computer. The server also 
controls the network access of the other 
computers which are referred to as the 
'client' computers. Typically, teachers and 
students in a school will use the client com-
puters for their work and only the network administrator (usually a designated 
staff member) will have access rights to the server. 

4.2.1 Components of a Network 

A computer network comprises the following components: 

 A minimum of at least 2 computers 
 Cables that connect the computers to each other, although wireless 

communication is becoming more common. 
 A network interface device on each computer (this is called a network 

interface card or NIC) 
 A ‘Switch’ used to switch the data from one point to another. Hubs are 

outdated and are little used for new installations. 
 Network operating system software 

  

Figure 37: Client/Server Network

Figure 36: Peer to Peer Network 
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4.2.2 Comparison between Peer-To-Peer and Client/Server Networks 

Peer-to-Peer Networks vs. Client/Server Networks 

Peer-to-Peer Networks Client/Server Networks 

Easy to set up More difficult to set up 

Less expensive to install More expensive to install 

Can be implemented on a wide range 
of operating systems 

A variety of operating systems can be 
supported on the client computers, but 
the server needs to run an operating 
system that supports networking 

More time consuming to maintain the 
software being used (as computers 
must be managed individually) 

Less time consuming to maintain the 
software being used (as most of the 
maintenance is managed from the 
server) 

Very low levels of security supported 
or none at all. These can be very 
cumbersome to set up, depending on 
the operating system being used 

High levels of security are supported, 
all of which are controlled from the 
server. Such measures prevent the 
deletion of essential system files or the 
changing of settings 

Ideal for networks with less than 10 
computers 

No limit to the number of computers 
that can be supported by the network 

Does not require a server Requires a server running a server 
operating system 

Demands a moderate level of skill to 
administer the network 

Demands that the network administra-
tor has a high level of IT skills with a 
good working knowledge of a server 
operating system 
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4.2.3 Structured Cabling 

The two most popular types of structured network cabling are twisted-pair (also 
known as 10BaseT) and thin coax (also known as 10Base2). 

A Network Interface Card NIC (pronounced 'nick') is also known as a network 
card. It connects the computer to the cabling, which in turn links all of the com-
puters on the network together. Each computer on a network must have a net-
work card. Most modern network cards are 10/100 NICs and can operate at 
either 10Mbps or 100Mbps.  

A hub is a device used to connect a PC to the network. The function of a hub is to 
direct information around the network, facilitating communication between all 
connected devices. 

A network operating system (NOS) is a computer operating system that is 
designed primarily to support workstations, personal computers and, in some 
instances, older terminals that are connected on a local area network (LAN). The 
salient features of network operating systems are: 

 Basic operating system features support like protocol support, processor 
support, hardware detection and multiprocessing support for applications 

 Security features: authentication, restrictions, authorization, access control 
 Features for file, Web service, printing and replication  
 Directory and name services management 
 User management features along with provisions for remote access and 

system management 
 Internetworking features like routing and WAN ports 
 Clustering capabilities 

Common tasks associated with network operating systems include: 

 User administration 
 System maintenance activities like backup 
 Tasks associated with file management 
 Security monitoring on all resources in the network 
 Setting priority to print jobs in the network 

4.3 Types of Computer Network according to geographical region 

 LAN(Local Area Networking) 
 WLAN(Wireless Local Area Networks) 
 WAN(Wide Area Networks) 
 MAN(Metropolitan Area Networks) 
 Internet 

4.3.1 LAN (Local Area Networking) 

Local Area Networking is used primarily in small areas such as schools, hospi-
tals and office buildings. Local Area Networking, is one of the older types of net-
works. TCP/IP is used as the method of communication between computers in 
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Local Area Networking. Due to its small size, it is possible for one person to ad-
ministrate a Local Area Network. Local Area 
Networks are viable to quick change, using a 
bus network topology that allows for easy 
access to the Local Area Network. 

4.3.1.1 Advantages of LANs: 

 A typical LAN network structure Hard-
ware such as printers can be shared so 
individual workstations do not need 
their own printer. When they print, the 
data is stored in a queue on a server. The 
data is then passed to the printer. 

 All the users work can be stored in a 
central place (the dedicated file server) so a user can access their work 
through any computer on the network. 

 Software can be shared, software packages are stored on the server and 
downloaded to workstations as requested. Note that a licence still has to 
be bought for each copy of the software needed. 

 Data can be shared because database files stored in the server are avai-
lable to users around the network; data from CD-ROMs can also be 
shared across the network. 

 Central back-up can take place automatically at regular intervals. A user 
will usually be able to retrieve work that has been deleted by mistake. 

 Messages can be sent to people working at other computers on the net-
work which can save time and paper. 

 It is possible to set up a local intranet such as that on the KLB school 
network. The web pages of information can be accessed only over the 
LAN.  An intranet is free because it does not involve phone links. 

 There is control over users’ access rights to programs and data. 

  

Figure 38: Local Area Network 
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4.3.1.2 Disadvantages of LANs: 

 Printing can be slow. Where a lot of workstations are served by only one 
or two printers, long print queues may develop. 

 A virus can spread more easily. If a virus gets into one computer, it is 
likely to spread quickly across the network because it will get into the 
central backing store. 

 As data is shared there is a greater need for security. Users of the network 
have to have authentication techniques such as user ids and passwords. 
Unique user ID's control access to the files and settings on the network 
while passwords prevent unauthorised users from logging onto the net-
work.  Data may also have to be encrypted so that it is meaningless if 
intercepted. 

 If the server fails, all the workstations are affected. Work stored on shared 
hard disk drives will not be accessible and it will not be possible to use 
network printers either. 

 The cost of installing the equipment is greater. Cabling can be expensive 
to buy and to install. 

 Damage to cables can isolate computers. Some sections of the network can 
become isolated and will not be able to communicate with the rest of the 
network. 

 Because networks can be complicated to maintain, a network manager 
may be need to be employed to run the system. 

4.3.2 WLAN (Wireless Local Area Networks) 

Wireless Local Area Networks are much 
like LAN networks, except they do not 
require network cables to connect each 
other. Radio and infrared signals are 
used to communicate between machines 
whilst using a wireless local area net-
work. Wireless Local Area Networks 
allow for small amounts of mobility 
whilst being connected to the internet. 
Wireless Local Area Networks work 

according to the IEEE 802.11 standards. 
Wireless Area Networks are commonly 
seen being used by a Wi-Fi internet connection. Wireless LAN connections offer a 
surprising amount of mobility for users with laptops and smart phones while 
being able to stay connected to the internet by different networking topology. 

  

Figure 39: Wireless LAN 
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4.3.2.1 Advantages of WLAN: 

 User mobility 
 Voice and data services 
 Access to central applications 
 Handover between access points 
 Robust model for industry 
 Economical access points 
 Plug-and-Play architecture 
 Robust controller 
 Security on the level of fixed networks 
 “Small Enterprise” option with own controller 
 “Branch Office” option for small branches where remote controller is used 

4.3.2.2 Disadvantages of WLAN: 

 As the number of computers using the network increases, the data trans-
fer rate to each computer will decrease accordingly. 

 As standards change, it may be necessary to replace wireless cards and/ 
or access points. 

 Lower wireless bandwidth means some applications such as video 
streaming will be more effective on a wired LAN. 

 Security is more difficult to guarantee and requires configuration. 
 Devices will only operate at a limited distance from an access point, with 

the distance determined by the standard used and buildings and other 
obstacles between the access point and the user. 

 A wired LAN is most likely to be required to provide a backbone to the 
WLAN; a WLAN should be a supplement to a wired LAN and not a com-
plete solution. 

 Long-term cost benefits are harder to achieve in static environments that 
require few moves and changes. 
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4.3.3 WAN (Wide Area Networks) 

Wide Area Networks are used to connect server machines and computers across 
continents are countries for constant information updates. Wide Area Networks, 
are used across the globe, many networks connect with one another across con-
tinents to create one giant Wide Area Network. Wide Area Networks use optic 
fibre as their communication medium. The largest example of a Wide Area Net-
work is the internet itself, which connects all users to the information and data 
that is available on the internet. 

 

Figure 40: Wide Area Network 

4.3.3.1 Advantages of WANs: 

 These are similar to those of LAN's except the scale of sharing etc. be-
comes far greater and can be world-wide. 

4.3.3.2 Disadvantages of WANs: 

 Again these are similar to those of LAN's except that issues such as secu-
rity become even more important as potential hackers could break into a 
computer system from anywhere in the world rather than having to 
physically be in a building. 

 Encryption of secure data such as financial transactions is necessary 
because it is even easier to intercept data. 
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4.3.4 MAN (Metropolitan Area Networks) 

Metropolitan Area Networks are not commonly used these days, they are used to 
create communication between systems in an entire city. Hence a Metropolitan 
Area Network area falls between the sizes Local Area Networks and Wide Area 
Networks. Metropolitan Area Networks are used by city specific businesses such 
as the New York Times in the state of New York. 

 

Figure 41: Metropolitan Area Network 

4.3.4.1  Campus Area Network 

A campus area network of computer network made up of an interconnection of 
LAN within limited geographical area 

4.3.4.2 Advantages of MAN 

 It provides a good back bone for a large network and provides greater 
access to WANs.  

 MAN can cover a wider area than a LAN.  
 MAN networks are usually operated at airports or a combination of 

several pieces at a local school. 
 By running a large network connectedness, information can be dissemi-

nated more widely, rapidly and significantly. 
 Public libraries and government agencies typically use a MAN. 

4.3.4.3 Disadvantages of MAN 

 It can be costly (hardware, software, support, etc 
 More cable required for a man connection from one place to another 
 The large the network becomes difficult to mange 
 It is difficult to make the system secure from hackers and industrial 

espionage 

4.3.5 Internet 

Although there are benefits to using a LAN or WAN, most individuals need to 
communicate with a resource on another network, outside of the local network 
within the home, campus or organization. This is done using the Internet. 
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Figure 42: Internet3 

As shown in Figure 42, the Internet is a worldwide collection of interconnected 
networks (internetworks or the Internet for short), cooperating with each other to 
exchange information using common standards. Through telephone wires, fiber-
optic cables, wireless transmissions and satellite links, Internet users can ex-
change information in a variety of forms. 

The Internet is an international collection of networks and is not actually owned 
by any individual or group. Ensuring effective communication across this 
diverse infrastructure requires the application of consistent and commonly re-
cognized technologies and standards as well as the cooperation of many network 
administration agencies. There are organizations that have been developed for 
the purpose of helping to maintain structure and standardization of Internet pro-
tocols and processes. These organizations include the Internet Engineering Task 
Force (IETF), Internet Corporation for Assigned Names and Numbers (ICANN) 
and the Internet Architecture Board (IAB), plus many others. 

  

                                                   
3 Source: http://ptgmedia.pearsoncmg.com/ 
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4.3.5.1 Connecting to the Internet  

There are many different ways to connect users and organizations to the Internet. 

Home users, teleworkers (remote workers) and small offices typically require a 
connection to an Internet service provider (ISP) to access the Internet. Connection 
options vary greatly depending on the ISP and the geographical location. How-
ever, popular choices include broadband cable, broadband digital subscriber line 
(DSL), wireless WANs and mobile services. 

Organizations typically require access to other corporate sites and the Internet. 
Fast connections are required to support business services, including IP phones, 
video conferencing and data center storage. 

Business-class interconnections are usually provided by service providers (SPs). 
Popular business-class services include business DSL, leased lines and Metro 
Ethernet. 

Connecting Remote Users to the Internet 
Figure 43 illustrates common Internet connection options for small office and 
home office users, which include: 

 Cable: Typically offered by cable television service providers, the Internet 
data signal is carried on the same coaxial cable that delivers cable tele-
vision. It provides a high-bandwidth, always-on connection to the Inter-
net. A special cable modem separates the Internet data signal from the 
other signals carried on the cable and provides an Ethernet connection to 
a host computer or LAN. 

 DSL: Provides a high-bandwidth, always-on connection to the Internet. It 
requires a special high-speed modem that separates the DSL signal from 
the telephone signal and provides an Ethernet connection to a host com-
puter or LAN. DSL runs over a telephone line, with the line split into 
three channels. One channel is used for voice telephone calls. This channel 
allows an individual to receive phone calls without disconnecting from 
the Internet. A second channel is a faster download channel, used to re-
ceive information from the Internet. The third channel is used for sending 
or uploading information. This channel is usually slightly slower than the 
download channel. The quality and speed of the DSL connection depends 
mainly on the quality of the phone line and the distance from your phone 
company’s central office. The farther you are from the central office, the 
slower the connection.  
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 Cellular: Cellular Internet access uses a cell phone network to connect. 
Wherever you can get a cellular signal, you can get cellular Internet 
access. Performance will be limited by the capabilities of the phone and 
the cell tower to which it is connected. The availability of cellular Internet 
access is a real benefit in those areas that would otherwise have no Inter-
net connectivity at all and for people who are constantly on the go. 

 Satellite: Satellite service is a good option for homes or offices that do not 
have access to DSL or cable. Satellite dishes require a clear line of sight to 
the satellite, so satellite service might not be an option in heavily wooded 
areas or places with other overhead obstructions. Speeds will vary 
depending on the contract, though they are generally good. Equipment 
and installation costs can be high (although check the provider for special 
deals), with a moderate monthly fee thereafter. The availability of satellite 
Internet access is a real benefit in those areas that would otherwise have 
no Internet connectivity at all. 

 Dial-up telephone: An inexpensive option that uses any phone line and a 
modem. To connect to the ISP, a user calls the ISP access phone number. 
The low bandwidth provided by a dial-up modem connection is usually 
not sufficient for large data transfer, although it is useful for mobile access 
while travelling. A modem dial-up connection should only be considered 
when higher-speed connection options are not available. 

 

Figure 43: Dialup Telephone 

Many homes and small offices are more commonly being connected directly with 
fiber-optic cables. This enables an ISP to provide higher bandwidth speeds and 
support more services such as Internet, phone and TV. 

The choice of connection varies depending on geographical location and service 
provider availability. 

  



 

85 

Connecting Businesses to the Internet  
Corporate connection options differ from home-user options. Businesses may 
require higher bandwidth, dedicated bandwidth and managed services. 
Connection options available differ depending on the number of service provi-
ders located nearby. 

Common connection options for organizations include: 

 Dedicated leased line: This is a dedicated connection from the service 
provider to the customer premises. Leased lines are actually reserved cir-
cuits that connect geographically separated offices for private voice and/ 
or data networking. The circuits are typically rented at a monthly or 
yearly rate, which tends to make it expensive. In North America, common 
leased-line circuits include T1 (1.54 Mbps) and T3 (44.7 Mbps), whereas in 
other parts of the world they are available in E1 (2 Mbps) and E3 (34 
Mbps). 

 Metro Ethernet: Metro Ethernet is typically available from a provider to 
the customer premises over a dedicated copper or fiber connection pro-
viding bandwidth speeds of 10 Mbps to 10 Gbps. Ethernet over Copper 
(EoC) is more economical than fiber-optic Ethernet service in many cases, 
is quite widely available and reaches speeds of up to 40 Mbps. However, 
EoC is limited by distance. Fiber-optic Ethernet service delivers the fastest 
connections available at an economical price per megabit. Unfortunately, 
there are still many areas where this service is unavailable. 

 DSL: Business DSL is available in various formats. A popular choice is 
symmetric DSL (SDSL), which is similar to asymmetric DSL (ADSL) but 
provides the same upload and download speeds. ADSL is designed to 
deliver bandwidth at different rates downstream than upstream. For 
example, a customer getting Internet access may have downstream rates 
that range from 1.5 to 9 Mbps, whereas upstream bandwidth ranges are 
from 16 to 640 kbps. ADSL transmissions work at distances up to 18,000 
feet (5,488 meters) over a single copper twisted pair. 

 Satellite: Satellite service can provide a connection when a wired solution 
is not available. Satellite dishes require a clear line of sight to the satellite. 
Equipment and installation costs can be high, with a moderate monthly 
fee thereafter. Connections tend to be slower and less reliable than 
terrestrial competition, which makes satellite less attractive than other 
alternatives. 

The choice of connection varies depending on geographical location and service 
provider availability. 

4.4 Network Topologies  

In computer networking, topology refers to the layout of connected devices. Net-
work topology is the configuration or physical arrangement in which devices are 
connected together  

Network topologies are categorized into the following basic types:  

 Bus  



86 

 Ring  
 Star  
 Tree  
 Mesh 

4.4.1 Bus Topology 

Bus networks (not to be confused with the system bus of a computer) use a 
common backbone to connect all devices. A single cable, the backbone functions 
as a shared communication medium that devices attach or tap into with an inter-
face connector. A device wanting to communicate with another device on the 
network sends a broadcast message onto the wire that all other devices see, but 
only the intended recipient actually accepts and processes the message. BUS 
networks: Single central cable connected a number of devices  

Ethernet bus topologies are relatively easy to install and don't require much 
cabling compared to the alternatives. 10Base-2 ("ThinNet") and 10Base-5 ("Thick-
Net") both were popular Ethernet cabling options many years ago for bus topo-
logies. However, bus networks work best with a limited number of devices. If 
more than a few dozen computers are added to a network bus, performance pro-
blems will likely result. In addition, if the backbone cable fails, the entire network 
effectively becomes unusable. 

 

Figure 44: Bus Topology 
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4.4.1.1 Advantages of a Linear Bus Topology  

 Easy to connect a computer or peripheral to a linear bus.  
 Requires less cable length than a star topology.  

4.4.1.2 Disadvantages of a Linear Bus Topology  

 Entire network shuts down if there is a break in the main cable.  
 Terminators are required at both ends of the backbone cable.  
 Difficult to identify the problem if the entire network shuts down.  
 Not meant to be used as a stand-alone solution in a large building. 

4.4.2 Ring Topology 

In a ring network, every device has 
exactly two neighbours for commu-
nication purposes. All messages 
travel through a ring in the same 
direction (either "clockwise" or 
"counterclockwise"). A failure in any 
cable or device breaks the loop and 
can take down the entire network.  

To implement a ring network, one typically 
uses Token Ring technology. Ring topologies are found in some office buildings 
or school campuses. 

Failure of any host results in failure of the whole ring. Thus every connection in 
the ring is point of failure. There exist methods which employs one more backup 
ring. 

Token Ring 
Token Passing (in brief) “Token” contains a piece of information which along 
with data is sent by the source computer. This token then passes to next node, 
which checks if the signal is intended to it. If yes, it receives it and passes the 
empty to into the network, otherwise passes token along with the data to next 
node. This process continues until the signal reaches its intended destination. 

The nodes with token are the ones only allowed to send data. Other nodes have 
to wait for an empty token to reach them. This network is usually found in 
offices, schools and small buildings. 

  

Figure 45: Ring Topology 
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Advantages of Ring Topology  
 The traffic is unidirectional and the data transmission is high-speed. 
 In comparison to a bus, a ring is better at handling load. 
 The adding or removing of network nodes is easy, as the process requires 

changing only two connections. 
 The configuration makes it easy to identify faults in network nodes. 
 In this topology, each node has the opportunity to transmit data. Thus, it 

is a very organized network topology. 
 It is less costly than a star topology. 
 There is no need for network server to control the connectivity between 

workstations. 
 Additional components do not affect the performance of network. 
 Each computer has equal access to resources. 

Disadvantages of Ring Topology 
 The failure of a single node in the network can cause the entire network to 

fail. 
 The movement or changes made to network nodes affect the entire net-

work's performance. 
 Data sent from one node to another has to pass through all the inter-

mediate nodes. This makes the transmission slower in comparison to that 
in a star topology. The transmission speed drops with an increase in the 
number of nodes. 

 There is heavy dependency on the wire connecting the network nodes in 
the ring. 
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4.4.3 Star Topology 

A star topology is designed with each node (file server, workstations and peri-
pherals) connected directly to a central network hub, switch or concentrator.  

Data on a star network passes through the hub, switch or concentrator before 
continuing to its destination. The hub, switch or concentrator manages and con-
trols all functions of the network. It also acts as a repeater for the data flow. This 
configuration is common with twisted pair cable; however, it can also be used 
with coaxial cable or fiber optic cable. 

 

Figure 46: Star Topology 

4.4.3.1 Advantages of a Star Topology  

 Easy to install and wire.  
 No disruptions to the network when connecting or removing devices.  
 Easy to detect faults and to remove parts.  
 As compared to Bus topology it gives far much better performance, 

signals don’t necessarily get transmitted to all the workstations. A sent 
signal reaches the intended destination after passing through no more 
than 3-4 devices and 2-3 links. Performance of the network is dependent 
on the capacity of central hub. 

 Easy to connect new nodes or devices. In star topology new nodes can be 
added easily without affecting rest of the network. Similarly components 
can also be removed easily. 

 Centralized management. It helps in monitoring the network. 
 Failure of one node or link doesn’t affect the rest of network. At the same 

time it’s easy to detect the failure and troubleshoot it. 
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4.4.3.2 Disadvantages of a Star Topology  

 Requires more cable length than a linear topology.  
 If the hub, switch or concentrator fails, nodes attached are disabled.  
 More expensive than linear bus topologies because of the cost of the hubs, 

etc.  
 Too much dependency on central device has its own drawbacks. If it fails 

whole network goes down. 
 The use of hub, a router or a switch as central device increases the overall 

cost of the network. 
 Performance and as well number of nodes which can be added in such 

topology is depended on capacity of central device. 

4.4.4 Tree Topology 

Tree topologies integrate multiple star topologies together onto a bus. In its 
simplest form, only hub devices connect directly to the tree bus and each hub 
functions as the root of a tree of devices. This bus/star hybrid approach supports 
future expandability of the network much better than a bus (limited in the 
number of devices due to the broadcast traffic it generates) or a star (limited by 
the number of hub connection points) alone. 

A tree topology combines characteristics of linear bus and star topologies. It 
consists of groups of star-configured workstations connected to a linear bus 
backbone cable. Tree topologies allow for the expansion of an existing network 
and enable schools to configure a network to meet their needs. 

 

Figure 47: Tree Topology 

4.4.4.1 Advantages of Tree Topology 

 It is an extension of Star and bus Topologies, so in networks where these 
topologies can't be implemented individually for reasons related to scala-
bility, tree topology is the best alternative. 
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 Expansion of Network is possible and easy. 
 Here, we divide the whole network into segments (star networks), which 

can be easily managed and maintained.  
 Error detection and correction is easy. 
 Each segment is provided with dedicated point-to-point wiring to the 

central hub. 
 If one segment is damaged, other segments are not affected. 

4.4.4.2 Disadvantages of Tree Topology 

 Because of its basic structure, tree topology, relies heavily on the main bus 
cable, if it breaks whole network is crippled. 

 As more and more nodes and segments are added, the maintenance 
becomes difficult. 

 Scalability of the network depends on the type of cable used. 

4.4.5 Mesh Topology 

In this type of topology, a host is connected to one or two or more than two 
hosts. This topology may have hosts having point-to-point connection to every 
other host or may also have hosts which are having point to point connection to 
few hosts only. 

 

Figure 48: Mesh Topology 

Hosts in Mesh topology also work as relay for other hosts which do not have 
direct point-to-point links. Mesh technology comes into two flavours: 

Full Mesh: All hosts have a point-to-point connection to every other host in the 
network. Thus for every new host n(n-1)/2 cables (connection) are required. It 
provides the most reliable network structure among all network topologies. 

Partially Mesh: Not all hosts have point-to-point connection to every other host. 
Hosts connect to each other in some arbitrarily fashion. This topology exists 
where we need to provide reliability to some host whereas others are not as such 
necessary. 
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4.4.5.1 Advantages of Mesh Topology 

 Data can be transmitted from different devices simultaneously. This 
topology can withstand high traffic. 

 Even if one of the components fails there is always an alternative present. 
So data transfer doesn’t get affected. 

 Expansion and modification in topology can be done without disrupting 
other nodes. 

4.4.5.2 Disadvantages of Mesh Topology 

 There are high chances of redundancy in many of the network connec-
tions. 

 Overall cost of this network is way too high as compared to other network 
topologies. 

 Set-up and maintenance of this topology is very difficult. Even adminis-
tration of the network is tough. 
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Activity 8 

Perform the following task and enlist the steps involved in 
performing the task. 

1) What is a computer network and why is it useful?  
2) What do networks look like and how do they work?  
3) What sorts of (hardware and software) tools are required 

to build a network?  
4) What are hubs, switches, routers and how do they work?  
5) What are the security implications of setting up a wired or wireless home 

network?  
6) How can I use home networking to share resources, such as an Internet 

connection, media and data and other resources?  

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 
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Activity 9 

Perform the following task and enlist the steps involved in 
performing the task. 

 

1) What 4 factors are involved in connecting to the Internet? 

1 ______________________________    2  _____________________

3 ______________________________    4  _____________________

 

2) Companies like AOL are called “ISPs”. What does ISP stand for? 

I  S  P 

 

3) Why is an “Anytime” type of Internet connection better than “Pay as you 
go” connections if a user makes frequent use of the Internet? 

 ________________________________________________________________

 ________________________________________________________________

 

 

4) a) What is the name of the type of software that is used to send and receive 
information on the Internet? 

 

 b) Examples of this type of software are browsers and e-mail clients.  
  What is the purpose of each of these programs? 

PROGRAM  Purpose

BROWSER 

E.g. Netscape Navigator   

E‐mail Client 

E.g. Eudora   
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5) Why is connecting using broadband better than connecting using a dial-up 

modem? 

  ________________________________________________________________

 

 

6) There are dangers to using the Internet - our information stored on the com-
puter is at risk. Explain what is meant by the 2 main dangers: viruses and 
hacking. 

Viruses  __________________________________________________________

 

 

Hacking __________________________________________________________
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Task 

Task 4 

 

The student should look upon the task as a test of knowledge, management skills 
and communication skills. When you write an answer asked in the task, you are 
indicating your knowledge to the teacher: 

 Your level of understanding of the subject. 
 How clearly you think. 
 How well you can reflect on your knowledge & experience. 
 How well you can use your knowledge in solving problems, explaining 

situations and describing organizations and management. 
 How professional you are and how much care and attention you give to 

what you do. 

Perform the following tasks and write down the steps how you have performed 
these tasks: 

1) Write a brief description of the function of all the components of Computer 
Network. 

2) List all network components installed on your lab PC, including clients, 
servers, network adapters and network topology.  

3) Prepare a physical diagram of a network. 
4) Describe three point-to-point network topologies with diagrams. 
5) Name 3 things that you need to connect to the Internet? 
6) Compare and contrast DSL and dial-up access networks. 
7) What are three characteristics of LANs that distinguish them from other net-

works? 
8) What are the main types of Cable used in connecting Networks? 
9) Differentiate between different Computer network topologies the functional 

relationship among nodes and the situations when each should be used.  
10) Draw a small model showing the layout of each of the following network 

topologies. Show and label each of the parts you remember, including hosts, 
hubs, terminating resistors, etc. 

 Bus 
 Ring 
 Tree 
 Star 
 Mesh 

Deadline:  
Your submission will be collected on January, 26th, 2015.  

 
If there are any questions, please do not hesitate to contact  

Dr. Shafiq ur Rehman via e-mail: shafiqurrehman1@yahoo.com  

 


